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Preface 

Purpose of this Document 
This document provides the installation and operation steps necessary to run the 
OrderPro application. This document is targeted for use with software upgrades to the 
new software structure introduced on Succession Enterprise 3.0 Globally.   
It also covers expansions made to Meridian 1 systems at X11 release 25 in the regions 
where this is supported. 

Intended Audience 
This guide is intended for those responsible for the installation and operation of 
OrderPro  

Structure of this Guide 
This guide is divided into the following chapters: 
 Overview 
 Getting Started 
 Understanding the OrderPro Interface 
 Extracting the Log File 
 Loading the Log File and sending it to Nortel if required 
 Reporting 
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Glossary 
NNEC - Nortel Networks Enterprise Configurator: is an 
application used for configuration and quotation purposes.   This tool 
is the re-branded version of Netprice 4.0 that is currently used in 
Europe, the Middle East, Africa, and Asia Pacific.  The tool will be 
further enhanced and introduced Globally. 
 
Netprice:  is a WEB-based application used in Europe, the Middle 
East, Africa and Asia Pacific for quotation purposes for Release 25.40 
and earlier.   
 
Meridian Configurator: is a PC-based application used for quotation and 
configuration purposes in Canada, the US and CALA. 
CVSD:  Customer Value Software Delivery – the Software structure introduced for 
all machine types (Succession and Meridian 1) Globally starting with Succession 
Enterprise 3.0.   
Americas:  Canada, United States and the Caribbean and Latin America (CALA) 
FBP:  Functionality Based Pricing – the pricing model that is used in Europe and 
Asia Pacific. Starting with Succession 3.0, FBP will move form its 8 bundle model to 
the 5 service level CVSD structure.  

Related Information 
This guide accompanies OrderPro online help. 

Contact Information 
Note: In countries where OrderPro has a number of users, you should contact your 
own OrderPro Channel Prime for support.  
EMEA 
escpm@nortelnetworks.com 
Tel: 00 800 8008 9009 or +44 (0) 20 8920 4618, Option 5  
CALA 
CALA_netprice@nortelnetworks.com 
CALA: 954 858-7788, Option 1  
Asia/Pacific 
Contact your FBP prime 
North America 

1-800-321-2649, opt 6, opt 2 
1-800-4Nortel, express routing code 7103 
 



 

OrderPro User’s Guide v6.0   1–1 

1 
Overview 

This chapter describes the OrderPro system. It contains the following sections: 
 What is OrderPro? 
 When do I need to Use Order Pro ? 
 OrderPro Features 
 Benefits of Using OrderPro  
 Upgrade/Expansion Software Order Process 
 Limitations of OrderPro 

 

What is OrderPro? 
OrderPro is a PC desktop application that repackages the software configuration on an 
existing Meridian 1 Release 15 or later system to the new CVSD software structure 
introduced with Succession 3.0. 
OrderPro is used to dial into an installed system to capture configuration information 
from the system.  The information gathered is then used to calculate the equivalent 
software service level in the CVSD software structure and the settings for the ISMs. 
OrderPro generates two reports that contain the new software structure result 
information, and well as a summary of the configuration information captured from the 
system,.  The reports can be viewed, printed and saved as a text file. 
OrderPro creates an encrypted file with a .OPI extension that is a component of the  
software upgrade ordering process globally.  

When do I need to Use OrderPro? 
Americas: 

Meridian 1 Release 15 and later systems require Order Pro to upgrade to Succession 
3.0 and later for the first time.   

Order Pro is NOT required for: 
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•  Systems already on the CVSD structure or on Succession 3.0 or later, do not 
require Order Pro for future upgrades or expansions.   

•  CSE 1000 Release 2.0 systems upgrading to Succession Release 3.0.   CSE 
1000 systems already use all of the ISMs in the CVSD structure and a bundled 
software package structure, such that the equivalent Service level and ISMs 
can be calculated based on the data form order history.   

•  OrderPro is not required for New Systems 

 

Europe and Asia Pacific: 

When upgrading to FBP for the first time, OrderPro is required.  OrderPro 6.0.x 
supports upgrades to Succession 3.0 for all machine types or to Release 25.40 for 
Large System C processor systems with EPE.OrderPro can be used for Expansions of 
systems already running an FBP release of software.  For small systems a site survey 
file is created which can be loaded into Netprice/NNEC.  For large systems OrderPro 
the information form the OrderPro reports can be used during the expansion process.  
OrderPro can be used to create a  LD 22 software inventory report for pre FBP systems 
in Europe. (not available in Asia Pacific) 
Order Pro is NOT  required for: 

•  Systems already on FBP that are upgrading to Succession 3.0 
•  CSE 1000 Release 2.0 systems upgrading to CVSD.   CSE 1000 systems 

already use all of the ISMs in the CVSD structure and a bundled software 
package structure, such that the equivalent Service level and ISMs can be 
calculated based on the data form order history.   

•  New Systems 

 

OrderPro Features 
OrderPro offers the following features: 

•  Repackages the installed software to the equivalent Service level in the CVSD 
Software Structure.  

•  Extracts the required hardware and software detail from the switch to calculate 
the Service and System ISMs settings when upgrading a switch to the CVSD 
Software Structure. 

•  Reads and outputs the enabled and consumed user levels when expanding or 
upgrading a switch within the FBP Structure 

•  Provides on screen report previews and printed report outputs, which can be 
saved as a text file for future reference. 

•  Reports provide data regarding the existing switch for entering on 
NetPrice/NNEC for Europe and Asia Pacific and in Meridian Configurator for 
the Americas. 
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•  Allows the user to choose a lower software service level than identified as 
their equivalent 

•  Allows the user to allocate spare/unused system capacity as either Analogue 
User ISMs or Digital User ISMs in the CVSD structure. 

•  Creates an encrypted file (.OPI) that Order Pro automatically sends via FTP to 
Nortel for the Americas for use in making the equivalent keycode for the 
system being upgraded.   

•  Reports the Upgrade Quantity required for quoting and ordering upgrades in 
the Americas.   

•  Identifies the following spare switch capacity: 

o Spare IPE slots  

o Spare network loops  

o Cabinet or networks groups that can be added to the switch. 

•  Reports the switch processor and memory.  
•  Provides the range of standard communications capabilities to use for 

accessing installed switches including dial-up, telnet, and direct connection. 
•  Provides modem scripting functionality 
•  Provides an address book feature to hold switch access details. 

 

Benefits of Using OrderPro 
OrderPro provides the following user benefits: 

 Automatically extracts and repackages the software features enabled 
on the switch to identify the equivalent CVSD service level and 
optional features required.  This ensures that all features currently 
installed on the system are carried forward the new structure. 

 No more X11 Software Order forms are required in North America for 
upgrades.  

 Automatically calculates the equivalent settings and types of users 
(ISMs) to set in the CVSD software structure, to support the existing 
switch.  This ensures that all capacity being used on the system is 
carried forward to the new CVSD structure.   

 Provides a range of data in two report formats, regarding the installed 
switch to support quoting and ordering for the installed base. 

 Supports remote polling of data from installed switches reducing the 
need for site surveys information. 

Upgrade/Expansion Software Order Process 
The OrderPro application repackages the installed software features  to the equivalent 
Service level in the CVSD Software Structure and calculates the equivalent ISM 
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values based on the hardware and software data extracted from the system.  An 
encrypted file with the extension .OPI is created in Order Pro which includes the 
Summary report information. 
 
For Europe and Asia Pacific:   
The .OPI file information is uploaded to NNEC to enable the quoting and ordering of 
upgrades to Succession 3.0. 
For the Americas (Canada, United States, and CALA):  
The .OPI file is sent to Nortel, via FTP or the Web, with each upgrade order.  The 
upgrade keycode is generated based on the values in the Order Pro .OPI file.  
 
 
 

Limitations of OrderPro 
The list below describes some of the limitations of OrderPro: 

1. Software releases that are lower than release 15 are not supported. 
2. Software releases other than X11, X81 and X91 are not supported. 
3. The Option 11C mini is identified by the MSC processor card or the 48 

port digital line card. If the SSC CPU exists in an 11C mini and the 48 
port line card does not exist then it will be seen as an Option 11C.  

4. On an Option 11C switch, OrderPro cannot distinguish between an Option 
11C Expansion Cabinet and Option 11C Mini Expansion Chassis (withor 
without an Option 11C Mini Chassis Expander). It calculates the number 
of unequipped IPE slots, based on there being 10 slots on the expansion. 

5. OrderPro is not able to recognize Mini Carrier Remotes and Multi Fibre 
Remotes sites. The equipment installed on these remotes are represented 
as being on the main site. 

6. The 24-port digital line card is not supported, and if this card is used, then 
adjustments must be made to any output given. The 24 port digital line 
card is not generally applicable, but there may be some sites with trial 
versions of this card which has been subsequently discontinued. 

7. PE, EPE, EEPE and RPE are not supported as far as spare slots are 
concerned, and where the card ID commands are used, such equipment 
will not be identified. Sets configured on the PE types will be counted for 
calculating new ISM values. 

8. OrderPro can detect Option 11 remote cabinets but cannot differentiate 
between copper and fiber expansion cabinets.  

9. For certain system generics with Omega processors, OrderPro cannot 
always distinguish the switch type, and the user may be asked to select the 
switch type from a limited choice. 

10. OrderPro cannot identify the media type for large switches running 
Release 23 software. 
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11. For Link/CCR and MAX applications, OrderPro cannot determine if the 

application is IPE or AEM. The user will be asked to verify the location of 
the applications. 

12. OrderPro requires the user to confirm when Call Pilot exists. 
13. The OrderPro extraction will not work when the switch is in the PDT 

(Problem Determination Tool) layer. It will be necessary to log out of the 
PDT layer prior to invoking the OrderPro extraction. 

14. OrderPro requires ITG Trunk cards to be installed in the system for the 
ITG Trunk ISM to be calculated correctly. 

15. RLOGIN connection is not supported by OrderPro If you wish connect to 
a Meridian 1 system using the Telnet connection option in OrderPro, then 
you must first connect OrderPro to a Server that supports rlogin, and then 
run the rlogin session manually from the command prompt in the OrderPro 
PBX Terminal screen. 

16. No Modem Auto detect in OrderPro - you need to know the configuration 
of the remote modem. 
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2 
Getting Started 

This chapter describes how to Install and get started with OrderPro on the users PC. It 
contains the following sections:  
 System Requirements 
 Installing OrderPro 
 Setting System Defaults 
 Getting Help 

System Requirements 
To successfully install and run OrderPro, you need: 
 Downloaded application from the Nortel Networks Customer web site as detailed 

below 
 A Personal Computer (PC), with Pentium 166 processor or higher 
 Microsoft Windows 95/98/2000/XP or an NT 4.0 Workstation 
 Approximately 10MB of hard disk space to download the .exe 

Additionally, to perform necessary data extractions and file transmissions, you may 
need: 
 A modem (Hayes compatible, or similar) 
 COM1 port availability 
 LAN Access 
 FTP or Internet access to send the .OPI file to Nortel (for the Americas) 

A mouse is highly recommended to take full advantage of the user interface. 
To install OrderPro, you need to first download the kit from the Nortel Networks web-
site. 
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Downloading OrderPro 
Before installing, you need to download the OrderPro executable file and associated 
documentation from Nortel Network's customer  web-site.  
 

Downloading via the Nortel Networks Customer web site 
To access the site you will need to enter your 'Secure Access Model' (SAM) user name 
and password. Electronic Software Download (ESD) must also be included on your 
SAM User Access Profile. 

You can download the latest version of OrderPro by connecting directly to the Nortel 
Networks Customer Support web site. You can go directly to the Customer Support 
site by using the following URL : 

http://www.nortelnetworks.com/support 

Alternatively, you can go to the Nortel Networks home page at: 

http://www.nortelnetworks.com/ 

From this page select “Support” which will also take you to the Nortel Networks 
Customer Support site. 

From here: 

1. Please select “Log In” from the left side menu.  
2. You will then be asked to enter your SAM User ID and password.  
3. Your personalised Customer Support Screen will then be presented. 
4. Select the “Products” hyperlink from the menu options on the left hand side 
5.  From the Alphabetical listing presented, select “O” 
6. Scroll down the list of products until you find “OrderPro” 
7. Select “Software” 
8. This takes you to the location to download OrderPro. Select “OrderPro Version 

6.0.x” 
9. Select File Download : option to download an executable file containing the 

current version of OrderPro. Download this OrderPro.exe file to your PC.  
 

Note : On Step 7 above you also have the option to select “Add to my Products”. By 
selecting this option will save the option to download OrderPro in your personal 
profile. 

•  Select “Add to my Products” 
•  Under MY Products on the left hand menu, you will now have OrderPro as an 

option in the drop down menu. 
 

Once the OrderPro executable has been downloaded and saved to your PC you are 
ready to commence the installation. 

1. Run the executable file. A wizard will start which will guide you through the 
installation procedure. 

2. The Order Pro User Guide and Release Notes are available for download as 
well.  In Step 7 above, rather than choosing software you can choose to 
download the User Guide or the Release Notes.  It is recommended you read 
this guide before using OrderPro. 
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Downloading via Netprice 
 If you are accessing the quote generator in NetPrice,  a link is provided to 

download OrderPro. By selecting this link you will be directed to the Nortel 
networks customer web site and can download OrderPro as detailed above.  

Requesting a Secure Access Model (SAM) ID  
If you do not have a SAM ID then choose 'Register' from the 'Nortel Networks 
Customer web site at 

 http://www.nortelnetworks.com/support 

and follow the registration process.  
 
 

Installing OrderPro 
If a previous version of OrderPro has been installed, it is recommended that it be 
removed prior tot loading the new version.  Uninstall the current version as follows:   
 Click Start -> Settings -> Control Panel 
 Select the Add/Remove Programs icon 
 On the Install/Uninstall tab, select OrderPro in the list of applications 
 Click the Add/Remove button to remove the application. 
 Run the downloaded OrderPro6.0.x.EXE file by double-clicking on its icon or, 

from the <Start><Run...> menu, by entering "[FullPath]/OrderPro6.0.x.exe" and 
then <OK>  

 Follow the instructions given by the Set-Up program 
  
 

Note - During the process of installing the Order Pro application, 2 type of incident 
may occur depending on your Windows platform: 
 MS Windows asks you if you wish to replace an existing file with an older version 

of this file deployed by OrderPro. Select "Yes" to keep your existing file. 
 MS Windows detects a conflict while installing a file because this file is in use. 

Select "Ignore" and continue the installation.  
 

Note - you must reboot your system after installing OrderPro if you are installing it for 
the first time.  If you do not reboot your system you will receive a flashing screen 
when you enter the OrderPro application.  If you have previously installed OrderPro 
and are installing a later version a system reboot is not required. 

Setting System Defaults 
When starting OrderPro for the first time, you need to set your system defaults. The 
System Defaults Screen allows you to customise your OrderPro system. The screen 
allows you to specify the Output Path, Output Extension, the Drive to use for storing 
Log files, and the Printer Font to use when printing reports.  
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The screen also requires that you specify your site location. The Site Location is a 
mandatory field.   The Site location represents the country or region that the Meridian 
1 system is located.  It is important that this location be correct, as it determines the 
logic that will be applied for the system conversion to the new software release.  If the 
site location is incorrect, then the software translation will also be incorrect and the 
upgrade keycode will not accurately reflect the software features or the capacity on the 
installed system.   
The screen is displayed in figure 2-1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure  2-1: System Defaults Screen 

Getting Help 
OrderPro provides both task and context sensitive help on the application. To view the 
help contents, select the Help option from the Main Screen, or click the F1 button for 
help on a screen.  
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3 
Understanding the OrderPro Interface 

This chapter describes how to use the OrderPro application. It contains the following 
sections: 
 OrderPro Components 
 The OrderPro Main Screen 

OrderPro Components 
The key components of OrderPro are as follows: 
 Log File 
 OPI file 
 The Upgrade Screen 
 Reports 

Log File 
The Log file is generated during the OrderPro extraction phase and is used to store all 
relevant data generated by the switch in response to the commands executed by the 
extraction script. The file can be named at the users' convenience. It contains 
information on the Software Release, Site ID/System serial number, System type, CPU 
and Memory and the feature list installed on the system. The Log file is loaded to 
allow the ISM and Repackaging algorithms perform calculations on the data stored in 
the Log file. Please refer to section 4 - Extracting the Lof File for more information. 

OPI File 
The OrderPro Interface file(OPI) is an encrypted file, that contains the information 
form the OrderPro Summary report.  The .OPI file is :   
For Europe and Asia Pacific - loaded to NetPrice/NNEC before a quote, to upgrade a 
switch from a pre-FBP Release. 
For the Americas, – sent to Nortel with  Succession 3.0 or later upgrade orders. 
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The Upgrade Screen 
The Upgrade Screen is primarily used to display the result of the repackaging and ISM 
calculations. Please refer to section 5 - Loading the Log File or more information. 

Reports 
The data captured in the Upgrade Screen is presented in the Summary Report. This 
report contains software information relating to software service levels and ISM 
values, which is required when quoting or ordering software upgrades/expansion to the 
CVSD model using NNEC. 
A detailed report is also available which gives information on system hardware. Please 
refer to the example reports in Appendix A. 

The OrderPro Main Screen 
The OrderPro Main Screen is used to start the extraction and loading phases.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Figure  3-1: Main Screen 
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Main Screen Menu Options 
The OrderPro screen contains three menu options: File, Upgrade and Help. 

File Menu 
The File Menu provides the following options: 
 System Defaults: This option is used to customise OrderPro settings. When 

OrderPro is run for the first time, the System Default Screen is displayed and 
requires you to enter the site location. For more information on the System 
Defaults Screen, see Chapter 2: Setting System Defaults. 

 Exit: Used to exit OrderPro. 

Upgrade Menu 
The Upgrade Menu is available for European Site Locations only.  It is greyed out (not 
available) for any other site locations.  
 

Help Menu 
The Help Menu provides the option to open the online help and view information on 
the OrderPro product. 

Main Screen Fields and Buttons 
The OrderPro Main Screen also contains the following fields and buttons. 
 Customer Name: Displays the customer name specified in the System Defaults site 

location. 
 Extract: Click this button to begin the process to extract the Log file from the 

Meridian 1 system. 
 Load: Click this button to begin loading a Log file. 
 Exit: Click this button to exit the application. 
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4 
Extracting the Log File 

This chapter describes how to perform an OrderPro extraction. It contains the 
following sections: 
 Setting-Up the Communication Link 
 Opening Dialog with the PBX  
 Extracting Data to the Log File 
 Using Address Books 
 Changing Modem Settings 
 Customizing Modem Scripts 

 

Setting-Up the Communication Link 
To perform an OrderPro extraction, a communication link needs to be established 
between the PC running OrderPro and the PBX.   
To set up the link, click the Extract button on the OrderPro Main Screen. The 
Connection Details Screen is displayed. This screen specifies the characteristics of the 
PBX (Phone No, Password, Connection type etc.) from which data is extracted.  
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Figure  4-1: Connection Details Screen 

Communication between the PC and PBX can occur in one of three ways: 
1. Modem: A remote connection implies that the PC and switch are not directly 

connected by one piece of cable (usually due to the distance between the two 
sources) but can communicate instead through means of modem. 

2. Direct: The PC is connected directly to the switch. 
3. Telnet: A telnet connection is required if you connect through a LAN to a 

server/PABX.  
Note: RLOGIN connection is not supported by OrderPro. If you wish connect to a 
Meridian 1 system using the Telnet connection option in OrderPro, then you must first 
connect OrderPro to a Server that supports rlogin, and then run the rlogin session 
manually from the command prompt in the OrderPro PBX Terminal screen. 
When this option is selected, the OrderPro PBX Terminal screen will the interface to 
the rlogin server, and following connection to the server, the normal procedure is 
followed to login to the Meridian 1 system and extract the log file. 
Clicking the Configure button allows you to specify communication settings (port 
number, modem speed, and connection preference). 
The Connection Details Screen supports the following parameters: 

File Menu 
The File Menu provides the following menu options: 
Terminal: Loads the PBX Terminal Screen. 
Address Book: Loads the Address Book Screen used to store PBX details or populate 
PBX details for the current communication.  
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Modem Commands: Loads the Modem Commands Screen, which contains the modem 
string initialization.  
Exit: Return to the Main Screen. 
Save as: Save user information in the address book 
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Fields and Buttons 
The Connection Details Screen provides the following fields and buttons: 
PABX User ID: Enter the user ID as defined for the “Login by User name” feature. If 
this feature is not configured then leave this field blank in which case OrderPro will 
confirm this to the user during the system login process. 
PABX Password: To access data from a switch, you must know the PABX password. 
Regardless of the type of connection in place, you must enter a password to retrieve 
the Log file. Please note that the password used (in conjunction with the system TTY 
port functionality) must be allowed to access the overlays used in the OrderPro 
extraction scripts. These are commonly used print overlays, plus maintenance overlay 
32 (please see later section on command scripts for full detail).  
Modem/Direct/Telnet: If a Modem connection is used, you need to specify the phone 
number of the target switch. If the switch and PC are in close proximity, a Direct 
connection may be used. A Telnet connection allows you to access a server/PBX via 
the LAN.  

Note: If you do not complete the required fields in the Connection Details 
Screen, you are prompted to enter that information (Phone Number of 
switch, PBX Password etc) later in the Extraction phase. It is recommended 
that you enter the details in the Connection Details Screen.  

 
Emulation: The terminal emulator. 
Log File Name: The name of the Log file that the PBX Terminal Screen is going to 
retrieve from the switch.  It is important to use a proper naming convention so that the 
files can be easily identified.  It is also helpful to keep the same file extension for all 
Log files (e.g. filename.log). Click on the field to browse the PC directories. 
OK: Clicking this button displays the PBX Terminal Screen, used to begin 
communication with the switch. 
Cancel: Clicking this button exits the screen and returns to the Main Screen without 
trying to retrieve a Log file. 
Configure: Clicking this button displays the Communication Settings Screen. 
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Figure  4-2: Communication Settings Screen 

The screen requires you to specify the following parameters: 
Connect Using: The port that is used by the PC to establish the connection must 
always be specified before pressing the OK button. 
Baud Rate: The baud rate specifies the speed of data transfer between the two 
communicating machines. The rate must always be specified, and the value may 
depend on the switch and/or modem settings. 
Connection Preferences: The Data Bits/Parity/Stop Bits options relate to the type of 
communication used in the data transfer. The settings may depend on switch and 
modem settings. 
Echo: Specifies the PBX Terminal Screen preference. 
Flow Control: This option relates to the type of communication used in data transfer 
and may depend on switch and modem settings. 

Note: OrderPro automatically saves the current settings when leaving the 
screen. If new default communication settings have been entered, they are 
retrieved as default settings when subsequently loading the application. 
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Opening Dialog with the PBX 
When the communication link has been established, OrderPro can start the dialog with 
the PBX. To load the PBX Terminal Screen, select the File->Terminal option on the 
Connection Details Screen.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure  4-3: PBX Terminal Screen 

The PBX Terminal Screen allows you to specify the appropriate parameters to create 
the Log file. There are three ways of proceeding with the extraction process: 
 Commands may be entered manually to establish connection with the PBX by 

typing it in the PBX Terminal Screen followed by the carriage return key. This 
method is not recommended as it can lead to data errors in the Log file. 

 Select the appropriate item in the Call menu. See Extracting Data to the Log File 
for more detail. 

 Use a combination of the above two options. 
If a problem should occur with the communication link, check the settings on the 
Connection Details Screen.   
If the Log file name is specified in the Connection Details Screen, it is automatically 
opened on entering the PBX Terminal Screen, and closed on exiting the PBX Terminal 
Screen. 
If no Log file name is specified, when you open the PBX Terminal Screen, you must 
open a Log file (using the File menu) to store the retrieved data. 
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The PBX Terminal Screen can be sized to full screen, and supports the following 
emulations: Auto, vtty, vt52, vt100, vt220 7 bits only, vt220 8 bits, vt320 7 bits only, 
vt320 8 bits. The Status Bar displays the following information: 
 Status: informs the user of the process status. For example, it may display the 

status “Waiting for REQ” or  “Analysing…” etc.  
 Settings: If the serial connection is used (direct or modem), the following is 

displayed for the connection: Speed, Parity, Data bits, Stop bit. If a Telnet 
connection is used, a counter is displayed listing the number of bytes downloaded 
in the Telnet port buffer. 

 COM 1; Shows the PC COM port used for direct and modem connections 
 Time: Displays the time the line is opened.  

The PBX Terminal Screen supports the following menu options: 

File Menu 
Open File: Displays the Open Communications Log File Screen, used to open a log 
file. To open the log file, you can also click in the Log file name field on the 
Connection Details Screen.  All the commands and responses from the PBX, displayed 
in the PBX Terminal Screen, are captured in this file. 
Note:  If a file name has been chosen in the Connection Details Screen, this option is 
disabled until the file is closed. 
Close File: Selected to close the file currently open.  It is not available if no file is 
opened.  
Open Line: Used to enter commands. This option may be disabled by choosing the 
Close Line option. It is not recommended to enter commands manually as it may lead 
to inaccurate data capture in the Log file.  
Close Line: Selected to close the line currently opened manually.  It is not available if 
no line is opened. 
Exit: Used to exit the PBX Terminal Screen and return to the Main Screen.  If a file is 
opened to capture the PBX details, selecting the Exit option closes it automatically. If 
the line has not been properly closed, OrderPro closes it at this stage. 

Options Menu 
Properties: This option allows you to toggle between the Connection Details Screen 
and the PBX Terminal Screen. 
Modem Commands: Loads the Modem Commands Screen where you can alter the 
modem commands.  
Address Book: Loads the Address Book Screen where PBX details can be stored, and 
from where PBX details for the current communication can be retrieved or modified. 
Customise Modem Scripts-Modify scripts: Loads the Modem Scripts screen, where 
you can create or edit your own scripts of commands See Customizing Modem Scripts 
for more detail. 
Customise Modem Scripts-Refresh menu: load the latest customised scripts if changed. 
Extraction Options: Enables or disables the detection of line feed characters during the 
extraction. 
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Default Window size: Returns the size of the PBX terminal window to default 

Call Menu 
Dial: Sends the initialisation string and dials the Meridian 1 System Phone Number as 
specified in the Connection Details Screen. 
System Login: Sends the initialisation string set in the Modem Settings Screen and 
then dials the phone number specified in the Connection Details Screen. It then sends 
the‘LOGI’ command to the switch. The system should respond with the ‘PASS’ 
prompt to which OrderPro responds automatically by the password set previously or 
prompts you for the password if it is not yet specified. Once OrderPro is logged into 
the system, some initial commands are sent (see Appendix B) to identify the features 
of the Meridian 1 system.  
[Modem Scripts: This is visible only if at least one script has been created. Its sub-
menu lists the existing modem scripts. Selecting a script from the sub-menu, 
automatically executes the commands defined in the script.] 
Data Extraction: automatically executes the commands for the data extraction. The 
extraction must be chosen if the system requires an upgrade to the CVSD model 
software. The system response to the extraction commands is stored in the Log file. 
Logout: Required to exit the system and close the connection. 

Help Menu 
Help on Extract: Provides help on the PBX Terminal Screen. 

System Errors 
It is known that most of the Meridian 1 systems are configured to report alerts and 
errors. These error messages can introduce corruption in the Log file. 
OrderPro removes as many of the errors in the Log file as possible when loading, 
errors can cause corruption and can cause the loading process to fail. 
If errors in the log file are causing the loading process to fail, then you should prevent 
the system from sending these error messages. It is possible to suppress them by 
disabling error reporting on the Meridian switch 
After extraction, error reporting should be re-enabled. 
OrderPro will not automatically suppress error reporting on the Meridian 1.  The 
OrderPro user must manually Disable Error reporting at the beginning and at the end 
of the extraction. For more information, see Appendix D. 

Extracting Data to the Log File 
To extract data to the Log file using the Call menu options: 
 Follow the steps to set up a communication link to the PBX. 
 Select the File -> Terminal menu option on the Configuration Details Screen. The 

PBX Terminal Screen is displayed. [Clicking the OK button on the Configuration 
Details Screen also displays the PBX Terminal Screen]. 
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 Select the Call -> Dial menu option [this step is only required if the 
Communication Settings have not already been specified in the Connection Details 
Screen] and enter the Meridian 1 Phone Number. 

 Select the Call -> System Logon menu option and enter the username and 
password if requested. 

 Select the Call -> Data Extraction menu option. The data extraction is used to 
extract required information from the installed switch by running an extraction 
script. The information generated in response to the script commands is saved to a 
pre-selected Log file [You need to specify a Log file name if it has not already 
been entered in the Connection Details Screen]. See Appendix B for details on 
extraction script commands and Appendix C for a list of the Meridian 1 Overlays 
that are accessed during the log file creation  

 Select the Call -> Logout menu option to log out of the Meridian 1 system. 
When using the Call Menu options, you can enter a <cr> command, or select the 
Cancel option to stop the extraction. If you choose the Cancel option, repeat the steps 
to perform an extraction. 
 

Using Address Books 
The Address Book facility allows you to save the properties of connections that you 
manage. The facility is useful when you need to re-access the same PBX or access 
server in the future. Using the Address Book, you can maintain and modify the 
Connection Type (Modem, Telnet) and Connection Details (Customer Name, Phone 
Number, Login ID and Password) associated with each PBX or access server.  
The Address Book Screen may be accessed from the Connection Details Screen by 
selecting the File -> Address Book menu option. The Address Book Screen can also be 
accessed from the PBX Terminal Screen by selecting Options -> Address Book.  
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Figure  4-4: Address Book Screen 

To create an Address Book entry, select a connection by clicking the appropriate 
button. Customer data is added by entering the details. The following details need to 
be specified for each connection:  
 Telnet: Enter the Customer Name, Server Name/IP Address, Port, Meridian 1 

Login ID, Meridian 1 Password, Server Login Name and Server Password Used.  
 Modem or Direct: Enter the Customer Name, Meridian 1 Phone Number, Login 

ID, and Password. This information does not appear for a modem connection.  
Communication Settings are contained in each bookmark, and entered by clicking the 
Configure button.   
Note: When a new version of OrderPro is installed, your Address Book is retained. 

Changing Modem Settings 
The Modem Commands Screen is accessed by selecting the File -> Modem 
Commands menu option on the Connection Details Screen, or by selecting the Options  
-> Modem Commands menu option on the PBX Terminal Screen.  
The Modem Commands Screen contains the modem initialisation string. The string 
may be modified if required to cater for modem settings on advanced communication 
applications. 
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Figure  4-5: Modem Commands Screen 

Customizing Modem Scripts 
OrderPro allows you to create your own customized modem scripts to specify the 
dialog to be used when accessing switches via secure modems. This allows standard 
scripts to be defined, saved, and reused rather than having to enter manually on the 
terminal screen for every modem access. To create and maintain a customized script, 
open the Modem Scripts screen from the options menu of the Terminal screen. 
This window lists the currently defined command scripts and allows you to add new 
scripts or change an existing script sequence. Once defined, a script may be called 
from the Terminal Screen Menu. 
The scripts you define remain from one OrderPro installation to another. 
The fields on this screen display the modem settings for more advanced 
communication applications. The settings may need to be modified when using 
specific modems. 
The generic commands, used by most brands of modem, are as follows: 

Dial :  AT DT AT command followed by Dial in TouchTone mode It 
takes a phone number as argument 

Hang Up prefix:  +++ escape sequence to drop the dtr line 

Hang Up suffix:  ATH modem on hook status 

Originate string: ATQ0E1V1M0S0=0 initialize the modem 

Guard Time: 1000ms A period of time during which the modem must 
not receive characters. The escape sequence (normally +++) has a guard 
time to ensure that data sent from a remote modem isn't interpreted as an 
escape sequence. For the modem to interpret an escape code as valid, there 
must be one second before and one second after the escape sequence in 
which the modem doesn't receive any characters. 

Notes: 

• All commands are prefixed with "AT" (Attention code) 
• S37=0/10 set modems bauds rates 
• S1=0 set modem to auto-answer 
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• M0/1/2/3 set sound volume (0=mute 3=loud) 
• Z restore Factory settings 

 

AT commands 
Useful information sources and links: 
http://www.dataip.freeserve.co.uk/Reference/ATCommands.html 
http://www.freenet.hamilton.on.ca/Help/Connect/ModemCommandsMore.html 
http://www.gci-net.com/support/DB/BasicHayesModemCommands.html 

 
Initialisation strings 

Useful information sources and links: 
http://www.netins.net/dialup/modems/init/ 
http://www.modemhelp.org/sets.html 
http://www-tei.uic.edu/depts/accc/network/dialin/modem_init.html 

 
 

Figure  4-6: Modem Scripts Screen 

 
Use this window to: 

 Add a new command script. 
 Change a command script sequence. 

 
As shown in the ScriptSample example in the figure above, your commands can 
contain requests to call regular User Prompts (such as UserName) and encrypted User 
Prompts (such as Password). It also support CTRL – x characters.  
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Note: if a command requires the Carriage Return (Enter key), then it must 
be added as part of the command line. 

Fields and Buttons: 
New: Create a new script with no command line. 
Add before: Insert command line in the list, on the line placed above the selected 
command line  
Add after: Insert command line in the list, on the line placed below the selected 
command line 
Replace: Change the selected command line to the new command line 
Remove: Remove the selected command line from the list 

Note: To remove a script from the list, select the script, delete every 
command line from the sequeneces list, and click Save As… 

Save As…: Save the current script 
Reset: restore the list of scripts and their content as they were when the screen was 
initially opened. 
Cancel: Exit the screen without saving any manipulation done on the screen since 
opened 
OK: Save permanently all the changes and exit the screen  

Note: The Modem Scripts Screen menu has corresponding options for all 
the commands above. 

 

Select a Script: presents you with the list of available scripts. Select a script in the list 
to modify it 
Send command…: Text to be sent from the PC to the communications equipment. It 
may contains Special commands  
…and wait for…: Command that must be sent from the remote modem to the local 
modem before the local modem can reply. 
Special Commands: double-clicking on one of the listed items to insert it in the 
command line: 

- Carriage Return (Only one Carriage Return allowed per command. Always 
placed at the end of the command line) 

- Prompt request (Orderpro will prompt the user to dynamically make an entry 
while running the script) 

- Encrypted Prompt request (Orderpro will prompt the user to dynamically 
make an entry while running the script.The entry will be encrypted as typed by 
the user.) 

Sequences: lists all the command lines and associated prompts defined for the selected 
scripts 
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5 
Loading the Log File 

This chapter describes how to load the Log file, and contains the following sections: 
 Overview of Loading 
 Pre-Validating the Log File 
 Calculating the ISM Values and Repackaging the Software 
 Generating and using .OPI files 

Overview of Loading 
The following steps are performed in the Loading phase: 
 Clean and pre-validate the Log file by: 

•  Removing non-relevant information from the Log file  

•  Inserting comments into the Log file to facilitate the manipulation program  

•  Ensuring all the information is available in the Log file to properly load the 
Log file. 

 Calculate the ISM values and Repackage the software to the CVSD model. 
To start the loading phase, click the Load button on the OrderPro Main Screen. The 
Load File Screen is displayed.  
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Figure  5-1: Load File Screen 

The screen displays the Existing tab that contains the following fields and buttons: 
Drives Available: Used to select the drive where the Log file resides. 
Look In: Used to select the folder where the Log file resides. 
Folder icon: shows the .log files in the default folder set up in system defaults 
Desk with light icon:  shows the .log files on the desktop 
File Name: Displays the selected file name. 
File of Type: Displays the file extension (.log) 
Previous: Clicking this button loads the last Log file selected with this screen. 
OK: Clicking this button validates selections and load the Log file. 
Cancel: Clicking this button cancels loading and exits the screen. 

  Clicking this button displays the contents of the default folder. 

 Clicking this button displays the contents of the desktop. 
 
The New tab is available only for Site Locations in Europe and is greyed (not 
available) out for all other site Locations.  

Pre-Validating the Log File 
OrderPro pre-validates the Log file by automatically executing the following tasks 
during the loading process:  
1. Cleaning: This step removes the following non-relevant information from the Log 

file: 
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 Convert characters downloaded in 7-bit format to a readable 8-bit format 
 All non-Windows ASCII characters. If the extraction has been performed with 

a different tool (RACE, SMARTTERM, etc.) some unexpected characters may 
have been stored in the Log file that may generate problems when OrderPro 
attempts to read them.  

 ASCII characters (ASCII code 0 to 7, 11, 12, 14 to 31, 127 to 159) 
 PAGE NO in the middle of PBX responses 
 Blank lines 
 Lines containing TIM XXX, DTC XXX, IOD XXX, BST XXX, BUG 
XXX. 

2. Commenting: OrderPro inserts comments into the Log file to facilitate the 
manipulation program and make files legible. This phase also ensures that every 
expected prompt and command are present in the file.  

3. Verification: Ensures that all the information required to load the Log file is 
present, and information to calculate or retrieve the ISM values is present. The 
ISM values are validated by checksum. 

4. Attempts to repair the CNT command response if corrupted. 

Calculating the ISM Values and Repackaging the Software 
The second part of the loading process involves calculating the ISM values and 
repackaging the software to the CVSD model. 
For upgrades to CVSD, certain ISM parameters are calculated (see Appendix C  
ISM Extraction Calculation). However for an expansion within the FBP model, the 
ISM parameter values are read directly from  overlay LD22. 
When upgrading to CVSD, all of the existing features installed on the Meridian 1 
system are mapped to their corresponding feature set in the new structure by the 
Repackaging algorithm. This enables OrderPro to identify the equivalent software 
Service Level in the new software structure that includes all of the features on the 
existing system.  

Loading Process Dialog Boxes 
For certain markets in Europe, OrderPro displays a dialog box that provides you with 
the available upgrade/expansion paths permitted. The options displayed in the dialog 
box are conditional on the installed software release on the PBX, and the installed 
release of software.  
During the loading process, configuration dependent questions and warnings may be 
shown in dialog boxes  

System type 
If the system generic is 11.11, 12.11 or 13.11, then a dialog box, similar to the 
following, may be displayed to prompt you to identify the system type. 
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Call Pilot 

 
If this message is displayed, OrderPro requires you to confirm if Call Pilot is 
configured on certain slots. Not all Call Pilot cards have Card IDs so OrderPro can 
only make assumptions based on the complete hardware configuration detected. Select 
Yes or No to confirm.  

Meridian Mail: 

 
If this message is displayed, OrderPro requires you to confirm if the version of Mail on 
the switch is the enhanced processor for card option. 

IPE applications: 
The following dialog box may also be displayed, if a number of applications existing 
on the system are IPE or AEM (modular) based:  
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If this is the case, the core system software does not provide OrderPro with sufficient 
information to determine if the application is IPE or AEM. You are required to enter 
the number of IPE Applications that are installed. 

Wall Mounted cabinet: 

 
If this message is displayed, OrderPro has detected a Carrier or Fibre remote site, 
which may be a wall mounted cabinet. 

Package mnemonics: 

 
If this message is displayed, OrderPro has detected a switch running release 15 or 16 
software. OrderPro is unable to associate a feature number with the mnemonic. To 
include it in the repackaging (your new keycode), you need to inform your regional 
Nortel Networks Support prime of the feature listed. 

XCT Shortage warning: 
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This is displayed when the number of detected XCT cards in the system is below the 
recommended guidelines (i.e. one XCT configured per half group). If displayed, click 
the OK button to continue.  

Obsoletes Features 
OrderPro displays the following message when it detects software features in the Log 
file that are not part of the CVSD software feature content. Note: such features will not 
exist in the new software: 
 
 
 
 

 
 
The following is an example to show that the log file requires cleaning 
 
 
 
 
 
 
 
When the load process commences, the following screen is displayed: 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



Loading the Log File 

OrderPro User’s Guide v6.0   5–7 

 

Repackaging the Software Features 
During the Loading of the log file, each feature on the installed system is mapped to 
one of the following categories: 

1. Service Level Features: These features in are included in one of the 5 
software Service Levels. As each feature is detected in the Log file it is 
mapped to the corresponding service level by the repackaging algorithm. The 
equivalent service level reported by OrderPro is the lowest service level in the 
CVSD structure that includes all of the Service level features on the system.  
Please refer to Appendix E for software package detail. 

2. Optional Features:  These features are optional and are not included in any of 
the 5 Service levels of the CVSD structure. If OrderPro detects any of these 
features in the Log file, it reports them in the OrderPro summary report as 
"Optional Features Detected".  These features will be included in the 
Succession 3.0 or later upgrade keycode for the system.   (see Appendix A for 
sample reports). 

3. Retired Features: These are features that are no longer supported in the new 
release. If they exist in the Log file, OrderPro displays a warning listing the 
features and indicating that they are not supported and will be removed from 
the keycode. These features are listed in the OrderPro Summary report as 
"Retired Features".  These features will not be included in the upgrade 
keycode for the system.  . 

4. System Specific Features: These are features that are dependent on your 
system type. They are mandatory features and are managed by Nortel 
Networks during the software manufacturing stage. The features will be 
automatically included for each system type listed below:  

Commercial  
System Type    System Specific Packages 
Option 11C chassis  200, 295 
Option 11C cabinet  200, 295 
*Succession 1000 M chassis 200, 295 
* This system type will not be offered in the EMEA Region 
 
Succession 1000 M cabinet  200, 295 
Option 61C CPP  227, 228, 286 & 368 
Succession 1000 M-SG  227, 228, 286 & 368 
Option 81C CPP  227, 228, 286, 368, 365 & 299 
Succession 1000 M-MG 227, 228, 286, 368, 365 & 299 
Succession 1000   200, 295 
Option 81                             227, 228, 286, 298, & 365 
Option 51C                             227, 228, and 286 
 
DSN Option 11C chassis 200, 295  
DSN Option 11C cabinet 200, 295  
DSN Option 61C CPP  227, 228, 286 & 368 
DSN Option 81C CPP   227, 228, 286, 368, 365 & 299 
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5. Features Not Supported in your Region: The 4 categories above include all 
of the features that are valid in the CVSD software structure.  Any feature not 
found in one of the 4 previously described software categories is reported in 
the OrderPro summary report as "Feature not Supported in your region".  
These features will be removed from the upgrade keycode for the system.  In 
order for any of these features to be included in your upgrade keycode Product 
Management approval will be required.   

 

The Upgrade Screen 
 
Once the loading process has run the ISM calculation and repackaging algorithm, the 
data generated is automatically loaded into the upgrade Screen.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Upgrade screen contains four sections: 
1. Details: displays information about the Meridian 1 system being upgraded 

including the existing software Release, Site ID/Serial number, Generic Value, 
System Type and CPU.   

2. Service Level: contains the Equivalent Service Level field, which displays the 
service level calculated by OrderPro after applying the repackaging algorithm to 
the list of existing software features from the Log file. You may downgrade to a 
lower Service Level, by selecting a lower service level in the 
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Desired Service Level field. The hierarchy of service levels is included in the 
following table. OrderPro displays the list of existing features that are removed from 
the configuration if a lower service level is selected.  From level 3a or level 3b you 
may downgrade to level 2.  You are not permitted to downgrade form level 3b to Level 
3a.   For more information on Downgrading please see the next section of this chapter.   

L4 - Premium Network Services 

L3a - Advanced Call Centre Services L3b - Advanced Network 
Services 

L2 - Enhanced Business Services 

L1 - Business Services 

 
3. Unequipped IPE Slots or Spare TN Allocations: Displays the unused capacity in 

the system.  For TN based systems the unused capacity is the amount of unused 
TNs on the system.  For non TN based systems the unequipped slots and ports  in 
the system are used to calculate the spare capacity. You may allocate none (enter 
0), all or any value in between of the spare capacity as either 'wired for' digital or 
"wired for analogue” users. Unallocated slots are identified as the 'spare slots 
remaining', and Spare TN are identified by the unused TNs on the current system. 
The numbers of 'wired for' digital and analogue users are calculated and included 
in the new keycode.    
OrderPro determines automatically whether to use Spare IPE slots or Unused TN 
according to Site Location  and system type. Please refer to appendix C for further 
detail. 
The following Upgrade screen capture shows how the Spare Capacity would  be 
reported for a TN based system 
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Important Note –  
The spare capacity in a system is based on the current system configuration. 
The OrderPro user has the option to carry forward all, none or any value in 
between of this spare capacity, to the new release. 
The quantity of spare capacity carried to the new release will directly affect 
the cost of the upgrade, as well as the cost of all future upgrades.  It is 
recommended that some spare capacity be carried forward for moves, 
changes and any known expansions, however it is also recommended that 
the quantity be carefully considered and accurately reflect the system 
requirements.   
If no spare ISMs are carried forward during the upgrade, then any future 
expansion would require the ordering of a new keycode. 

4. Report Preview: Enables you to preview the OrderPro summary and detailed output 
report. 
The Upgrade Screen contains the following buttons: 
 Print: Used to generate a hardcopy of the OrderPro Upgrade to report. 
 Save: Used to generate a softcopy of the OrderPro report to a folder.  
 View Report (or Hide Report): Used to preview the OrderPro reports.  

For EMEA and APAC only 
 Generate an Upload File for NetPrice: Use to generate an encrypted report file 

with a .opi extension for subsequent loading to NetPrice/NNEC. 
For US, Canada and CALA only 
 Save and Send OPI file: Use to sned the .OPI file to Nortel networks using FTP.  If 

the user is not connected to an external network, then the user will be required to 
send the .OPI file at a later time when they are connected to the network.   
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Downgrading the Service Level Identified by OrderPro 
OrderPro allows to the user downgrade the Service Level and identifies the features 
that will be removed from the system keycode when a lower service level is selected.  

Caution:  

  When features are being removed from a system: 
•  Perform a data backup prior to prior to the Succession 3.0 upgrade 
•  Any programming associated with the features must be removed prior to the 

upgrade to Succession 3.0 in order to prevent potential data conversion problems 
during the upgrade.  

 
Features that will be removed as a result of choosing a lower service level than 
identified by OrderPro will be shown on the upgrade Screen under the Lost features 
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Generating and Using .OPI Files 
Depending on which region you have selected for your site location, the button on the 
Succession 3.0 Upgrade Screen in Order Pro to generate and save the OPI file will be 
either: 
Save & Send OPI File – for the Americas 
Generate Site Survey File for Netprice – For Europe and Asia Pacific 

Using OPI Files in the Americas  
When the Send & Save OPI File button is selected, the OPI file is generated based on 
the information found in the Summary Report.  The Wired for values on the Upgrade 
screen must be completed with a value.  If the Wired for Values on the Upgrade to 
Succession 3.0 screen are not completed, Order Pro displays a message asking that you 
complete these fields.  If no wired for values are desired, simply enter 0 for both 
Analog and Digital Wired for.   
Order Pro will confirm where the user would like to save the OPI file on the PC.   
Order Pro opens the default directory as specified in the System Defaults screen.     
 

OPI File Name Format for the Americas 
Order Pro will automatically name the OPI file as follows and does not allow the user 
any option to change the OPI file name.  The Nortel systems are expecting and will 
validate for an OPI filename in the OrderPro format: 
Serial#_date_time.OPI  where: 
Serial#:  is the Serial number of the system, and where an characters are in capitals 
Date:  in the format ddmmyyyy as read by OrderPro from LD 2 during the .log file 
extraction 
Time:  in the format hhmm  as read by OrderPro from LD 2 during the .log file 
extraction.  If OrderPro fails to identify the date and time of the extraction from the LD 
2 overlay (corruptions / invalid date format), OrderPro doesn’t generate a critical error, 
but uses the PC date and time from the first line of the LOG file, which it  always 
inserts before starting an extraction. 
 

OrderPro automatically FTPs the file to Nortel for the Americas 
Once OrderPro has saved the OPI file in the designated directory it opens the built in 
FTP application and attempts to automatically send the OPI file to the required Nortel 
server.  If the file transfer is successful the user receives a message indicating so.  
If the file transfer fails (PC is not connected to the internet, Server down, etc...), 
OrderPro displays the following Warning message “OPI file has not been sent to 
remote server"  You must re-load the LOG file once connected to the internet or send 
it using the Web alternative. 
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Example Upgrade screen during transfer of .OPI file 
 
 
 
 
 

 
Screen showing completed file transfer 
 

Order Pro files can be Sent to Nortel using http File Transfer 
If a user is unable to transfer files using the built in FTP function in  
OrderPro, they can transfer OPI files using using the http file transfer functionality of 
Internet Explorer.  Open your Internet Explorer and go to the following URL:  
http://ftp4.nortelnetworks.com/opi/upload.asp 
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You will be prompted with a Security Warning asking  “  Do you want to install and 
run Persits software Jupload Applet” ….?  You must say Yes to proceed.   
For User enter:  opi 
For Password:  opi1 
Leave the domain blank 
Follow the instructions at the bottom of the screen and any messages displayed to 
transfer your OPI file(s) to the Nortel server.   
An error message will be displayed if you attempt to transfer anything other than a file 
with a .OPI extension.  You will receive appropriate messages if you file transfer is 
successful or not.  

Things to Remember for the Upgrade Purchase Order 
•  The exact .OPI filename is required to be in the text field of the Upgrade 

Purchase Order 
•  The quantity of Upgrade to Succession 3.0 upgrade codes must match the 

“Upgrade Quantity” field from the Order Pro Summary report.   
 

Using OPI Files in EMEA and Asia Pacific (FBP Regions) 
When the Generate Site Survey File for Netprice button is selected, the OPI file is 
generated based on the information found in the Summary Report.  If the Wired for 
Values on the Upgrade to Succession 3.0 screen are not completed, Order Pro displays 
a message asking that you complete these fields.  If no wired for values are desired, 
simply enter 0 for both Analog and Digital Wired for.   
Order Pro will confirm where you would like to save the OPI file.   
Once created the OPI file is uploaded into the NNEC quotation and configuration tool.
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A 
Reporting 

This chapter describes how to use the OrderPro application to generate reports. It 
contains the following sections: 
 Overview of Reports 
 The OrderPro Reports provides information under the following headings: 
 Report header:  Provides details of the report date, log file extraction date, the site 

location selected and the log file name 
 System information:  Provides a summary of the system details including the 

system type, serial number, Aux ID, memory processor and the upgrade Quantity.   
The upgrade Quantity is included in the Americas reports and represents the total 
number of users being upgraded to the new release.   
Upgrade Quantity =     Total Analogue Users ISM  
   + Total Digital User ISM 
   + CLASS User ISM 
   + Internet User ISM 
   + Wireless User ISM 
The upgrade Quantity is an important value since it is required for the Upgrade 
purchase order in the Americas.   

 Equipped ISMs - details the values calculated by OrderPro for the System and 
Service ISMs.  In the CVSD Structure, several of the ISM increments are sold in 
units of 8.  For any ISM sold in increments of 8, OrderPro will round up to the 
nearest 8 the value that it calculates for the equivalent number of that ISM type.  

 
 
 
 

 Service ISMs: 
 
For Americas: 
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Total Analogue User ISM  = Configured Analog ISMs+Wired for Analogue - 
will be rounded up to the nearest value divisible by 8 
Total Digital  User ISM  = Configured Digital ISMs+Wired for Digital - will 
be rounded up to the nearest value divisible by 8 
 
For Europe and Asia Pacific 

 Digital  User ISM  
 Analogue User ISM -  
 
 For all regions: 
 CLASS User ISM - will be rounded up to the nearest value divisible by 8 
 Internet User ISM - will be rounded up to the nearest value divisible by 8 
 Wireless User ISM - rounded up to the nearest value divisible by 8 
 ACD Agent  ISM  
 
 System ISMs: 
 ITG Trunk ISMs - will be rounded to the nearest value divisible by 8 
 IP Peer H323 
 RAN Con 
 MUS Con 
 AST 
 

 Wired for ISMs - the amount of unused capacity that is being carried forward to 
the new release. 

 Remote Site Information 
 Detected Service levels 
 Software Features:  Lists the equivalent service level as calculated by OrderPro 

(reported as detected), the desired service level (will be the same as the detected 
unless a lower level was chosen by the user), the optional features, system specific 
features, retired features and the features not supported  for the site location 
selected.   

 Generating Reports 

Overview of Reports 
The OrderPro Reports provides information under the following headings: 
 Report header:  Provides details of the report date, log file extraction date, the site 

location selected and the log file name 
 System information:  Provides a summary of the system details including the 

system type, serial number, Aux ID, memory processor and the upgrade Quantity.   
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The upgrade Quantity is included in the Americas reports and represents the total 
number of users being upgraded to the new release.   
Upgrade Quantity =     Total Analogue Users ISM  
   + Total Digital User ISM 
   + CLASS User ISM 
   + Internet User ISM 
   + Wireless User ISM 
The upgrade Quantity is an important value since it is required for the Upgrade 
purchase order in the Americas.   

 Equipped ISMs - details the values calculated by OrderPro for the System and 
Service ISMs.  In the CVSD Structure, several of the ISM increments are sold in 
units of 8.  For any ISM sold in increments of 8, OrderPro will round up to the 
nearest 8 the value that it calculates for the equivalent number of that ISM type.  

 
 
 
 

 Service ISMs: 
 
For Americas: 
Total Analogue User ISM  = Configured Analog ISMs+Wired for Analogue - 
will be rounded up to the nearest value divisible by 8 
Total Digital  User ISM  = Configured Digital ISMs+Wired for Digital - will 
be rounded up to the nearest value divisible by 8 
 
For Europe and Asia Pacific 

 Digital  User ISM  
 Analogue User ISM -  
 
 For all regions: 
 CLASS User ISM - will be rounded up to the nearest value divisible by 8 
 Internet User ISM - will be rounded up to the nearest value divisible by 8 
 Wireless User ISM - rounded up to the nearest value divisible by 8 
 ACD Agent  ISM  
 
 System ISMs: 
 ITG Trunk ISMs - will be rounded to the nearest value divisible by 8 
 IP Peer H323 
 RAN Con 
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 MUS Con 
 AST 
 
 Wired for ISMs - the amount of unused capacity that is being carried forward to 

the new release. 
 Remote Site Information 
 Detected Service levels 
 Software Features:  Lists the equivalent service level as calculated by OrderPro 

(reported as detected), the desired service level (will be the same as the detected 
unless a lower level was chosen by the user), the optional features, system specific 
features, retired features and the features not supported  for the site location 
selected.   

Generating Reports 
OrderPro generates both Summary and Detailed Reports, and displays report output in 
the Upgrade Screen. Reports are accessed by clicking on the View Reports button on 
the Upgrade Screen. 
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Figure A-1: FBP Screen - Report Menu Options 

 
The reports can be saved to a file or printed using the Save Summary report or Print 
Summary report buttons or by using the equivalent options in the File Menu. 
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Sample Reports 
This appendix contains the following sample reports: 
 OrderPro 6.0 Summary Report for North American Large system 
 OrderPro 6.0 Detail Report for North American Large system 
 OrderPro 6.0 Summary Report for North American Small system 
 OrderPro 6.0 Detail Report for North American Small system 
 OrderPro 6.0 Summary Report for EMEA Large system 
 OrderPro 6.0 Detail Report for EMEA Large system 
 OrderPro 6.0 Summary Report for EMEA Small system 
 OrderPro 6.0 Detail Report for EMEA Small system 
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OrderPro 6.0 Summary Report for North American Large system 

 

OrderPro 6.0.2 
Upgrade to Succession 3.0 Report 
____________________________ 

 
Report Date     : 10-07-2003 
Extraction Date : 17-06-2003 
Site Location   : Canada 
LOG File Name   : d:\Profiles\BHackwit\Desktop\Qwest_81C.LOG 

____________________________ 
 

System 

 

System Type : Option 81C with IGS 
Serial Number : Z00087 
Aux ID : N/A 
Generic : 3011 
Release : 26.07N 
CPU Memory : 128 M-Bytes 
CPU Processor : 68060E NT5D03 
Media Type : CD ROM 
Software Type : Commercial 
Total Upgrade Quantity : 524 
 

ISMs 

Service ISMs: 
Total Digital user ISM : 272 (rounded up) 
Total Analogue user ISM : 168 
Wireless user ISM : 16 
Wireless Visitors user ISM : 0 
ACD agent ISM : 200 
CLASS ISM : 8 (rounded up) 
Internet Telephones ISM : 60 
 
System ISMs: 
TMDI D-Channel ISM : N/A 
RAN CON ISM : N/A 
MUS CON ISM : N/A 
ITG2 Trunks ISM : N/A 
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BRANDLine ISM : N/A 
LTID (ISDN BRI) ISM : N/A 
Survivable ISM : N/A 
Personal Call Assistant ISM : 10 
IP Peer H323 Trunks ISM : 0 (set to alternate value) 
AST ISM : 200 
 

Wired for ISMs 
 
Wired for digital user ISM : 32 
Wired for analogue user ISM : 32 
 
Existing Switch Spare Capacity 
 
Existing Number of Spare IPE Slots on Main Switch :  25 
Existing Number of Cabinets :N/A 
Existing Number of CE MUX Slots Not Occupied by CE MUX Cards :N/A 
Existing Number of Spare Network Loops :   35 
Existing Number of Spare Slots on Non-Blocking S'loops : 0 
Existing Number of Equipable IPE Modules : 1 
Number of additional Network Groups which can be added to the switch : 3 
 
Remote Site Information 
 
Existing Number of Remote sites :  0 
 
Site Text Existing Number Fiber/Carrier 
 of Spare Slots Remotes 
----- 0 ----- 
 
Software Features 
 
Detected Service Level : Premium Network Services 
Desired Service Level : Premium Network Services 
Optional Features detected : 22 
System Specific features : 65 - 227 - 228 - 299 
Retired features : 84 
Features not Supported in your Region : 0 
Features removed (when downgrading) : 0 
Additional features (when upgrading) : 26 - 27 - 65 - 79 - 129 - 154 - 159 - 183 - 184 - 202 - 
208 - 209 - 224 - 225 - 233 - 249 - 297 - 315 - 321 - 327 - 328 - 330 - 331 - 388 - 393 - 399 
 
Manual Entries 
 
Is there a Call-Pilot configured on slot 13 and 14 of Shelf #4? 
=> YES 
 
{end of file}  



Sample Reports 

OrderPro User’s Guide v6.0   A–9 

 
 

OrderPro 6.0 Detailed Report for North American Large system 
 

 

OrderPro 6.0.2 
Detailed Report 

____________________________ 
 

Report Date     : 10-07-2003 System Type:Option 81C-IGS 

Extraction Date : 17-06-2003 Release:26.07N 

Site Location   : Canada Serial No.:Z00087 

LOG File Name   : d:\Profiles\BHackwit\Desktop\Qwest_81C.LOG 

____________________________ 

 

Peripheral Equipment Totals 

 

Code Qty. Description 

CALPILOT   1 IPE Call Pilot 
CARD DOW   2 Card down - Slot used 
NT0966BA   2 Media Card with ITG2.1 Application load 
NT1R20AB   1 Extended Line Card Off-Premises 
NT5D51AA   1 ABC PC Teleconference for M1 
NT5D60AA   1 
NT5G11AA   1 MICA Pack without Security Device 
NT5G71AA   1 Meridian Integrated Personal Call Directory Base Card 
NT7D16AA   2 X-CALIBUR DATA ACCESS PCBA 
NT8D02AA   3 Digital Line Card 16 Port 
NT8D02AB   6 Digital Line Card 16 Port 
NT8D03AB   3 
NT8D09AB   2 
NT8D09AK   2 Flexible Analogue Line Card with High Voltage Message Waiting 
NT8D09AL   1 Flexible Analogue Line Card with High Voltage Message Waiting 
NT8D14AH   1 
NT8D14AJ   1 EXTENDED UNIVERSAL TRUNK PCBA 
NT8D15AA   1 EXTENDED UNIVERSAL TRUNK 2 PCBA 
NT8D16AB   1 Card 8-channel Extended Digitone Receiver XDTR 
NTAG36AA   1 MIRAN Pack Assy with Security Device 
NTCK90AA   1 CMCC CT2 Meridian1 Controller 
NTDF29AA   1 Remote Digital Extender Card Rapport 
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NTDR70AC   1 32 Port Reach Line Card - Option 51C - 81C 
UNEQUIPP  25 
 

 

Peripheral Equipment Details 

 

Site Module# Slot S'Loop Code Unused Ports 

Main 1  0  004 NT8D02AB 0 
 1  1  004 NT8D03AB 1 
 1  2  004 NT8D02AB 11 
 1  3  004 NT8D02AB 12 
 1  4  004 NT8D16AB  
 1  5  004 NT1R20AB 1 
 1  6  004 NT8D14AJ  
 1  7  004 NT8D14AH  
 1  8  004 NT8D09AK 0 
 1  9  004 NT8D15AA  
 1  10 004 NT8D02AB 10 
 1  11 004 NTAG36AA  
 1  12 004 NT8D09AB 0 
 1  13 004 NT5G71AA 12 
 1  14 004 NT5G11AA 11 
 1  15 004 NT0966BA  
Main 'C4M4' 3  0  056 NT8D02AB 0 
 3  1  056 NT8D02AA 3 
 3  2  056 NT8D02AA 0 
 3  3  056 NT8D03AB 2 
 3  4  056 NT8D03AB 1 
 3  5  056 NT7D16AA 0 
 3  6  056 NT7D16AA 0 
 3  7  056 NT8D02AB 0 
 3  8  056 NTCK90AA 7 
 3  9  056 NT8D09AK 0 
 3  10 056 NT5D51AA 4 
 3  11 056 NTDF29AA 14 
 3  12 056 UNEQUIPPED  
 3  13 056 UNEQUIPPED  
 3  14 056 UNEQUIPPED  
 3  15 056 UNEQUIPPED  
Main '04' 4  0  048 NT8D02AA 13 
 4  1  048 NT8D09AB 0 
 4  2  048 NT8D09AL 2 
 4  3  048 UNEQUIPPED  
 4  4  048 CARD DOW 14 
 4  5  048 UNEQUIPPED  
 4  6  048 UNEQUIPPED  
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 4  7  048 UNEQUIPPED  
 4  8  048 NTDR70AC 5 
 4  9  048 ========  
 4  10 048 CARD DOW  
 4  11 048 NT0966BA  
 4  12 048 UNEQUIPPED  
 4  13 048 CALPILOT 8 
 4  14 048 ========  
 4  15 048 NT5D60AA  
Main '5' 5  0  048 UNEQUIPPED  
 5  1  048 UNEQUIPPED  
 5  2  048 UNEQUIPPED  
 5  3  048 UNEQUIPPED  
 5  4  048 UNEQUIPPED  
 5  5  048 UNEQUIPPED  
 5  6  048 UNEQUIPPED  
 5  7  048 UNEQUIPPED  
 5  8  048 UNEQUIPPED  
 5  9  048 UNEQUIPPED  
 5  10 048 UNEQUIPPED  
 5  11 048 UNEQUIPPED  
 5  12 048 UNEQUIPPED  
 5  13 048 UNEQUIPPED  
 5  14 048 UNEQUIPPED  
 5  15 048 UNEQUIPPED  
 

Note that the Peripheral equipment does not identify any AEM and associated Applications, nor 
any EPE equipment, which may exist. 

 

System Memory Allocation 

 

CP 4 
DRAM:  32 + 32 + 0 + 0 
Flash:  64 
 

Networks Summary 

 

 Grp0 Grp1 Total 
ENET 2 0 2 
REM 0 0 0 
SUPL 4 8 12 
SUPC 0 0 0 
SUPF 0 0 0 
DDCS 0 0 0 
XCT 4 4 8 
TDS 0 0 0 
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CONF 0 0 0 
DTI 0 0 0 
PRI 6 1 7 
PRI2 0 0 0 
DTI2 0 0 0 
MISP 0 0 0 
JDMI 0 0 0 
SPARE 16 19 35 
 

Networks Details 

 

Group Loop Code Group Loop Code 
0 0 XCT 1 32 SPARESLOOP 
0 1 XCT 1 33 SPARESLOT 
0 2 PRI 1 34 SPARESLOT 
0 3 PRI 1 35 SPARESLOT 
0 4 SUPL* 1 36 PRI 
0 5 SUPL* 1 37 SPAREPRI 
0 6 SUPL 1 38 SPARESLOT 
0 7 SUPL 1 39 SPARESLOT 
0 8 SPARESLOOP 1 40 SPARESLOOP 
0 9 SPARESLOT 1 41 SPARESLOT 
0 10 SPARESLOT 1 42 SPARESLOT 
0 11 SPARESLOT 1 43 SPARESLOT 
0 12 SPARESLOOP 1 44 SPARESLOT 
0 13 SPARESLOT 1 45 SPARESLOT 
0 14 SPARESLOT 1 46 XCT 
0 15 SPARESLOT 1 47 XCT 
0 16 XCT 1 48 SUPL* 
0 17 XCT 1 49 SUPL* 
0 18 PRI 1 50 SUPL 
0 19 PRI 1 51 SUPL 
0 20 ENET 1 52 SPARESLOOP 
0 21 ENET 1 53 SPARESLOT 
0 22 PRI 1 54 SPARESLOT 
0 23 PRI 1 55 SPARESLOT 
0 24 SPARESLOOP 1 56 SUPL* 
0 25 SPARESLOT 1 57 SUPL* 
0 26 SPARESLOT 1 58 SUPL 
0 27 SPARESLOT 1 59 SUPL 
0 28 SPARESLOOP 1 60 SPARESLOT 
0 29 SPARESLOT 1 61 SPARESLOT 
0 30 SPARESLOT 1 62 XCT 
0 31 SPARESLOT 1 63 XCT 
 

* indicates position of superloop 
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- The detailed network report shows how the equipment is configured in software, and does not 
necessarily give a true definition of hardware e.g. PRI2 could be an ENET card connected to 
the older dual width PRI2, or could be a DPRI. 

- Where spare loops are shown, the capability of these loops may be limited by configuration of 
adjacent loops. 

- SDI/DCH/MSDL are not included on the report as their location and card type cannot be 
determined in all cases. 

- Virtual Loops are shown as Phantom Loops 

- Phantom loops are only shown when they are configured within the actual system equipment. 

- Mini Carrier Remotes and Multi-IPR Fibre Remotes content are shown as installed on the 
Main Switch. 

- Unused ports may include ports, which are reserved for future Console use. 

 

{end of file}  
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OrderPro 6.0 Summary Report for North American Small system 
 
 

 

OrderPro 6.0.2 
Upgrade to Succession 3.0 Report 

____________________________ 

 

Report Date     : 10-07-2003 
Extraction Date : 12-06-2003 
Site Location   : Canada 
LOG File Name   : D:\Profiles\BHackwit\Desktop\US_910025_2540.LOG 

____________________________ 

 

System 
System Type : Option 11C 
Serial Number : 910025 
Aux ID : 910025 
Generic : 2111 
Release : 25.40 
CPU Memory : 48 M-Bytes 
CPU Processor : SSC NTDK20 
Media Type : N/A 
Software Type : Commercial 
Total Upgrade Quantity : 170 
 

ISMs 
Service ISMs: 
Total Digital user ISM : 104 (rounded up) 
Total Analogue user ISM : 24 (rounded up) 
Wireless user ISM : 32 (rounded up) 
Wireless Visitors user ISM : 0 
ACD agent ISM : 39 
CLASS ISM : 0 
Internet Telephones ISM : 10 
 

System ISMs: 
TMDI D-Channel ISM : N/A 
RAN CON ISM : 0 
MUS CON ISM : 0 
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ITG2 Trunks ISM : 24 
BRANDLine ISM : N/A 
LTID (ISDN BRI) ISM : N/A 
Survivable ISM : 1 
Personal Call Assistant ISM : 0 (set to alternate value) 
IP Peer H323 Trunks ISM : 0 (set to alternate value) 
AST ISM : 1 
 

Wired for ISMs 
Wired for digital user ISM : 24 
Wired for analogue user ISM : 0 
 

Existing Switch Spare Capacity 
Existing Number of Spare IPE Slots on Main Switch : 4 
Existing Number of Cabinets including remotes : 3 
Existing Number of CE MUX Slots Not Occupied by CE MUX Cards :N/A 
Existing Number of Spare Network Loops :N/A 
Existing Number of Spare Slots on Non-Blocking S'loops :N/A 
Existing Number of Equipable IPE Modules :N/A 
Number of additional Network Groups which can be added to the switch :N/A 
 

Remote Site Information 

Existing Number of Remote sites :  0 

Site Text Existing Number Fiber/Carrier 
 of Spare Slots Remotes 
----- 0 ----- 
 

Software Features 
Detected Service Level : Premium Network Services 
Desired Service Level : Premium Network Services 
Optional Features detected : 22 
System Specific features : 200 - 295 
Retired features : 0 
Features not Supported in your Region : 0 
Features removed (when downgrading) : 0 
Additional features (when upgrading) : 120 - 159 - 183 - 224 - 225 - 245 - 249 - 259 - 388 - 
393 - 394 - 397 - 398 - 399 
 

Manual Entries 
Is there a Call-Pilot configured on slots 6 and 7 of Cabinet #3 ? 
=> YES 
 
{end of file}  
 



Sample Reports 

A–16   OrderPro User’s Guide v6.0    

 
 

OrderPro 6.0 Detailed Report for North American Small system 
 

 

OrderPro 6.0.2 
Detailed Report 

____________________________ 

 

Report Date     : 10-07-2003 System Type : Option 11C 
Extraction Date : 12-06-2003 Release : 25.40 
Site Location   : Canada Serial No. : 910025 
LOG File Name   : D:\Profiles\BHackwit\Desktop\US_910025_2540.LOG 

____________________________ 

 

Peripheral Equipment Totals 

Code Qty. Description 
AnalogLC   1 Analogue line card with unknown ID 
CALPILOT   1 IPE Call Pilot 
DigitalL   2 Digital line card with unknown ID 
MVLC NT8   1 
MWLC NT8   1 
NPR CODE   1 Error code - Slot Used 
NT0966AA   1 Pentium 24/30 Pack Assembly with ITG 2.0 Application Load 
NT8D02AB   4 Digital Line Card 16 Port 
NT8D09AK   1 Flexible Analogue Line Card with High Voltage Message Waiting 
NTCK91AB   1 Meridian Companion Radio Line Card 
NTDR71AB   1 Dual Mig Reach Line Card - Opt 11 
NTVQ55AA   1 ITG Lineside Pentium Assembly  with Pre-Programmed 
PRI        3 
SDI/DCH    2 
SL1_LC     1 
UNEQUIPP   4 
 

 

Peripheral Equipment Details 

Site/Connection Cab# Slot Code Unused Ports 
Main 0 0 NTDK20 
 0 1 SDI/DCH  
 0 2 SDI/DCH  
 0 3 PRI  
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 0 4 DigitalLC 7 
 0 5 PRI  
 0 6 UNEQUIPPED  
 0 7 PRI  
 0 8 NT8D02AB 1 
 0 9 UNEQUIPPED  
 0 10 NPR CODE 6 
Expansion 1 0 
 1 1 NT0966AA  
 1 2 ========  
 1 3 NT8D02AB 1 
 1 4 NT8D02AB 1 
 1 5 NTVQ55AA  
 1 6 ========  
 1 7 MWLC NT8 15 
 1 8 MVLC NT8 0 
 1 9 NT8D02AB 1 
 1 10 DigitalLC 9 
Expansion 2 0 
 2 1 AnalogLC 7 
 2 2 NTCK91AB 10 
 2 3 NTDR71AB 8 
 2 4 ======== 16 
 2 5 NT8D09AK 15 
 2 6 CALPILOT 0 
 2 7 ========  
 2 8 UNEQUIPPED  
 2 9 UNEQUIPPED  
 2 10 SL1_LC   0 
 

- Note that remote cabinets cannot be distinguished from cabinets in the same location as the 
main switch. 

- Option 11C Expansion Cabinet and Option 11C Mini Expansion Chassis (with or without an 
Option 11C Mini Chassis Expander) are always represented with 10 slots available on an 
expansion of an Option 11C. 

- Mini Carrier Remotes and Multi-IPR Fibre Remotes content are shown as installed on the 
Main Switch. 

- Unused ports may include ports, which are reserved for future Console use. 

 

{end of file}  
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OrderPro 6.0 Summary Report for EMEA Large system 
 

 

OrderPro 6.0.2 
Upgrade to FBP Release 26 Report 

____________________________ 

 

Report Date     : 10-07-2003 
Extraction Date : 13-11-2002 
Site Location   : Schrack Business Com 
LOG File Name   : D:\Profiles\BHackwit\Desktop\Polk .opi\original logs\Gdansk61.log 

____________________________ 

 

System 
System Type : Option 61C 
System ID : 430100031 
Aux ID : N/A 
Generic : 1811 
Release : 20.22S 
CPU Memory : 24 M-Bytes 
CPU Processor : 68030 NT6D66 
Media Type : Floppy Disk 
Software Type : Commercial 
 

ISMs 
Service ISMs: 
Digital user ISM : 107 
Analogue user ISM : 112 
Wireless user ISM : 0 
Wireless Visitors user ISM : N/A 
ACD agent ISM : 10 (set to minimum) 
CLASS ISM : 0 
Internet Telephones ISM : 0 (set to alternate value) 
 

System ISMs: 
TMDI D-Channel ISM : 0 (set to alternate value) 
RAN CON ISM : 0 (set to alternate value) 
MUS CON ISM : 0 (set to alternate value) 
ITG2 Trunks ISM : 0 (set to alternate value) 
BRANDLine ISM : 2 (set to alternate value) 
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LTID (ISDN BRI) ISM : 0 
Survivable ISM : 0 (set to alternate value) 
Personal Call Assistant ISM : 0 (set to alternate value) 
IP Peer H323 Trunks ISM : 0 (set to alternate value) 
AST ISM : 32767 
 

Wired for ISMs 
Wired for digital user ISM : 32 
Wired for analogue user ISM : 32 
 

Existing Switch Spare Capacity 
Existing Number of Spare IPE Slots on Main Switch : 8 
Existing Number of Cabinets :N/A 
Existing Number of CE MUX Slots Not Occupied by CE MUX Cards :N/A 
Existing Number of Spare Network Loops : 6 
Existing Number of Spare Slots on Non-Blocking S'loops : 0 
Existing Number of Equipable IPE Modules : 2 
Number of additional Network Groups which can be added to the switch :N/A 
 

Remote Site Information 
Existing Number of Remote sites :  0 
 
Site Text Existing Number Fiber/Carrier 
 of Spare Slots Remotes 
----- 0 ----- 
 

Software Features 
Detected Service Level : Premium Network Services 
Desired Service Level : Premium Network Services 
Optional Features detected : 22 - 284 
System Specific features : 227 - 228 
Retired features : 0 
Features not Supported in your Region : 0 
Features removed (when downgrading) : 0 
Additional features (when upgrading) : 38 - 56 - 60 - 93 - 110 - 124 - 143 - 149 - 167 - 174 - 
225 - 240 - 250 - 256 - 262 - 288 - 289 - 296 - 297 - 301 - 305 - 306 - 307 - 309 - 311 - 312 - 
315 - 316 - 321 - 323 - 324 - 325 - 327 - 328 - 348 - 350 - 351 - 362 - 364 - 366 - 367 - 370 - 
380 - 381 - 382 - 384 - 386 - 387 - 388 - 389 - 394 - 397 - 398 - 399 
 

Manual Entries 

None 

 

{end of file}  



Sample Reports 

A–20   OrderPro User’s Guide v6.0    

 

OrderPro 6.0 Detailed Report for EMEA Large system 
 

 

OrderPro 6.0.2 
Detailed Report 

____________________________ 

 

Report Date     : 10-07-2003 System Type : Option 61C 
Extraction Date : 13-11-2002 Release : 20.22S 
Site Location   : Schrack Business Com System ID : 430100031 
LOG File Name   : D:\Profiles\BHackwit\Desktop\Polk .opi\original logs\Gdansk61.log 

____________________________ 

 
Peripheral Equipment Totals 
 
Code Qty. Description 
IDSG  00   1 Digital voice synthesizer 
NT5K02EA   4 Flexible Analogue Line Card With Message Waiting 
NT5K21BA   2 Card 4 Channel MFC (MFC 4) 
NT5K48AB   1 Extended Dial Tone Detector 
NT5K96EA   2 Flexible Analogue Line Card Non Message Waiting 
NT5K96EB   1 Card 16-port Extended Flexible Analogue Line XFALC 
NT8D02CC   6 Digital Line Card 16 Port 
NT8D02GA   1 Card 16-port Extended Digital Line XDLC 
UNEQUIPP  12 
XMPT  00   1 Kapsch equipment 
 

 

Peripheral Equipment Details 
 
Site Module# Slot S'Loop Code Unused Ports 
Main '02' 1  0  004 NT5K21BA  
 1  1  004 NT5K96EA 0 
 1  2  004 NT5K96EB 7 
 1  3  004 NT8D02GA 0 
 1  4  004 UNEQUIPPED  
 1  5  004 NT5K48AB  
 1  6  004 IDSG  00  
 1  7  004 UNEQUIPPED  
 1  8  004 UNEQUIPPED  
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 1  9  004 NT8D02CC 1 
 1  10 004 NT8D02CC 0 
 1  11 004 NT8D02CC 2 
 1  12 004 NT8D02CC 0 
 1  13 004 NT8D02CC 0 
 1  14 004 UNEQUIPPED  
 1  15 004 UNEQUIPPED  
Main 'C00M03' 2  0  020 UNEQUIPPED  
 2  1  020 NT8D02CC 0 
 2  2  020 NT5K02EA 0 
 2  3  020 NT5K02EA 0 
 2  4  020 XMPT  00  
 2  5  020 ========  
 2  6  020 UNEQUIPPED  
 2  7  020 UNEQUIPPED  
 2  8  020 UNEQUIPPED  
 2  9  020 NT5K02EA 0 
 2  10 020 NT5K02EA 0 
 2  11 020 NT5K96EA 0 
 2  12 020 UNEQUIPPED  
 2  13 020 UNEQUIPPED  
 2  14 020 UNEQUIPPED  
 2  15 020 NT5K21BA  
 

Note that the Peripheral equipment does not identify any AEM and associated Applications, nor 
any EPE equipment, which may exist. 
 

System Memory Allocation 
CP 1 
DRAM:  4 + 4 + 4 + 4 + 4 + 4 
Flash:  Not Applicable 
 

Networks Summary 
 Grp0 Total 
ENET 0 0 
REM 0 0 
SUPL 8 8 
SUPC 0 0 
SUPF 0 0 
DDCS 1 1 
XCT 4 4 
TDS 0 0 
CONF 0 0 
DTI 0 0 
PRI 0 0 
PRI2 10 10 
DTI2 3 3 
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MISP 0 0 
JDMI 0 0 
SPARE 6 6 
 

Networks Details 
Group Loop Code 
0 0 XCT 
0 1 XCT 
0 2 DTI2 
0 3 DTI2 
0 4 SUPL* 
0 5 SUPL* 
0 6 SUPL 
0 7 SUPL 
0 8 SPARESLOOP 
0 9 SPARESLOT 
0 10 SPARESLOT 
0 11 SPARESLOT 
0 12 PRI2 
0 13 PRI2 
0 14 DDCS 
0 15 SPAREDDCS 
0 16 XCT 
0 17 XCT 
0 18 PRI2 
0 19 PRI2 
0 20 SUPL* 
0 21 SUPL* 
0 22 SUPL 
0 23 SUPL 
0 24 PRI2 
0 25 PRI2 
0 26 PRI2 
0 27 PRI2 
0 28 DTI2 
0 29 SPAREDTI2 
0 30 PRI2 
0 31 PRI2 
* indicates position of superloop 

 

- The detailed network report shows how the equipment is configured in software, and does not 
necessarily give a true definition of hardware e.g. PRI2 could be an ENET card connected to 
the older dual width PRI2, or could be a DPRI. 

- Where spare loops are shown, the capability of these loops may be limited by configuration of 
adjacent loops. 

- SDI/DCH/MSDL are not included on the report as their location and card type cannot be 
determined in all cases. 
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- Virtual Loops are shown as Phantom Loops 

- Phantom loops are only shown when they are configured within the actual system equipment. 

- Unused ports may include ports, which are reserved for future Console use. 

 

{end of file}  
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OrderPro 6.0 Summary Report for EMEA Small system 
 

 

OrderPro 6.0.2 
Upgrade to FBP Release 26 Report 

____________________________ 

 

Report Date     : 10-07-2003 
Extraction Date : 14-11-2002 
Site Location   : Schrack Business Com 
LOG File Name   : D:\Profiles\BHackwit\Desktop\Polk .opi\original 
logs\Krakow_off_11.log 

____________________________ 

 

System 
System Type : Option 11E 
System ID : 800475 
Aux ID : 800475 
Generic : 1411 
Release : 20.22 
CPU Memory : 640 K-words 
CPU Processor : Option 11E CPU N/A 
Media Type : N/A 
Software Type : Commercial 
 

ISMs 
Service ISMs: 
Digital user ISM : 32 
Analogue user ISM : 16 
Wireless user ISM : 0 
Wireless Visitors user ISM : N/A 
ACD agent ISM : 10 (set to minimum) 
CLASS ISM : 0 
Internet Telephones ISM : 0 (set to alternate value) 
 
System ISMs: 
TMDI D-Channel ISM : 64 (set to alternate value) 
RAN CON ISM : 0 (set to alternate value) 
MUS CON ISM : 0 (set to alternate value) 
ITG2 Trunks ISM : 0 (set to alternate value) 
BRANDLine ISM : 2 (set to alternate value) 
LTID (ISDN BRI) ISM : 0 
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Survivable ISM : 0 (set to alternate value) 
Personal Call Assistant ISM : 0 (set to alternate value) 
IP Peer H323 Trunks ISM : 0 (set to alternate value) 
AST ISM : 0 
 
Wired for ISMs 
Wired for digital user ISM : 16 
Wired for analogue user ISM : 0 
 
Existing Switch Spare Capacity 
Existing Number of Spare IPE Slots on Main Switch : 3 
Existing Number of Cabinets : 1 
Existing Number of CE MUX Slots Not Occupied by CE MUX Cards :N/A 
Existing Number of Spare Network Loops :N/A 
Existing Number of Spare Slots on Non-Blocking S'loops :N/A 
Existing Number of Equipable IPE Modules :N/A 
Number of additional Network Groups which can be added to the switch :N/A 
 

Remote Site Information 
Existing Number of Remote sites :  0 
Site Text Existing Number Fiber/Carrier 
 of Spare Slots Remotes 
----- 0 ----- 
 

Software Features 
Detected Service Level : Premium Network Services 
Desired Service Level : Premium Network Services 
Optional Features detected : 22 
System Specific features : 200 
Retired features : 82 
Features not Supported in your Region : 0 
Features removed (when downgrading) : 0 
Additional features (when upgrading) : 38 - 56 - 60 - 93 - 110 - 122 - 123 - 124 - 143 - 149 - 
165 - 167 - 174 - 225 - 231 - 240 - 242 - 245 - 246 - 250 - 256 - 262 - 283 - 288 - 289 - 296 - 
297 - 301 - 305 - 306 - 307 - 309 - 311 - 312 - 315 - 316 - 321 - 323 - 324 - 325 - 327 - 328 - 
348 - 350 - 351 - 362 - 364 - 366 - 367 - 370 - 380 - 381 - 382 - 384 - 386 - 387 - 388 - 389 - 
394 - 397 - 398 - 399 
 
Manual Entries 
 
None 
 
{end of file}  
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OrderPro 6.0 Detailed Report for EMEA Small system 

 

OrderPro 6.0.2 
Detailed Report 

____________________________ 
 

Report Date     : 10-07-2003 System Type : Option 11E 
Extraction Date : 14-11-2002 Release : 20.22 
Site Location   : Schrack Business Com System ID : 800475 
LOG File Name   : D:\Profiles\BHackwit\Desktop\Polk .opi\original 
logs\Krakow_off_11.log 

____________________________ 
 

Peripheral Equipment Totals 
Code Qty. Description 
NT5K96EA   1 Flexible Analogue Line Card Non Message Waiting 
NT8D02CC   1 Digital Line Card 16 Port 
NT8D02EA   1 Digital Line Card 16 Port 
PRI2       2 
UNEQUIPP   4 
X2T   00   1 8 Port analog Trunk Card 
 
Peripheral Equipment Details 
Site/Connection Cab# Slot Code Unused Ports 
Main 0 0 N/A 
 0 1 PRI2  
 0 2 NT8D02EA 0 
 0 3 PRI2  
 0 4 NT5K96EA 7 
 0 5 X2T   00  
 0 6 NT8D02CC 5 
 0 7 UNEQUIPPED  
 0 8 UNEQUIPPED  
 0 9 UNEQUIPPED  
 0 10 UNEQUIPPED  
 
- Note that remote cabinets cannot be distinguished from cabinets in the same location as the 
main switch. 
- Option 11C Expansion Cabinet and Option 11C Mini Expansion Chassis (with or without an 
Option 11C Mini Chassis Expander) are always represented with 10 slots available on an 
expansion of an Option 11C. 
- Unused ports may include ports, which are reserved for future Console use. 
{end of file}  
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B 
Command Scripts 

This appendix contains the following command scripts: 
 Initial Extraction – All Systems 
 Pre-Extraction – Option11x Systems 
 Pre-Extraction – Large Systems 
 LD 81 REQ  
 CNT CUST  

1.  DATE  
2.  PAGE  
3.  DES  
4.  FEAT  
5. SETS FEAT  
6.  NACT  
7.  REQ  
1. **** > 
 Main Extraction – Option11x Systems 
 Main Extraction – Large Systems 

Initial Extraction – All Systems  
1. **** > 
2. LD 22 REQ 
3. ISS REQ 
4. END > 

Pre-Extraction – Option11x Systems 
5. LD 97 > 
6. or1... REQ 
7. PRT TYPE 
8. XPE TYPE 
9. or2... XPEC 
10.  REQ 
11. end or2  
12. **** > 
13. end or1  
14. LD 20 REQ 
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15. LUC REQ 
16. END > 
17. LD 20 REQ 
18. LUU REQ 
19. or1... TYPE 
20. 500 TN 
21.  REQ 
22. or2... CDEN 
23.  REQ 
24. end or2  
25. Unconfig TYPE /* LUU (rls>19) or LUVU 
26. 2000 TN 
27.  REQ 
28. end or1  
29. END > 
30. LD 22 REQ 
31. ISS REQ 
32. PRT TYPE 
33. PKG 370 TYPE 
34. or1... REQ 
35. PRT TYPE 
36. end or1  
37. Equipment REQ /* CEQU (rls>19) or CFN  
38. END > 
39. LD 32 . 
40. Idle NPR506 
41. or1... . 
42. Disabled . 
43. Busy . 
44. Idle . 
45. Disabled . 
46. Busy . 
47. Idle . 
48. Disabled . 
49. Busy . 
50. Idle . 
51. Disabled . 
52. Busy . 
53. end or1  
54. **** > 
55. LD 81 REQ  
56. CNT CUST  
57.  DATE  
58.  PAGE  
59.  DES  
60.  FEAT  
61. SETS FEAT  
62.  NACT  
63.  REQ  
64. **** >  

Pre-Extraction – Large Systems 

65. LD 97 > 
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66. or1... REQ 
67. PRT TYPE 
68. XPE TYPE 
69. or2... XPEC 
70.  REQ 
71. end or2 
72. **** > 
73. end or1 
74. LD 20 REQ 
75. LUU REQ 
76. or1... TYPE 
77. 500 TN 
78.  REQ 
79. or2... CDEN 
80.  REQ 
81. end or2 
82. Unconfig TYPE /* LUU (rls>19) or LUVU 
83. 2000 TN 
84.  REQ 
85. end or1 
86. **** > 
87. LD 22 REQ 
88. PRT TYPE 
89. PKG 370 REQ 
90. or1... TYPE 
91. end or1 
92. **** > 
93. LD 81 REQ  
94. CNT CUST  
95.  DATE  
96.  PAGE  
97.  DES  
98.  FEAT  
99. SETS FEAT  
100.  NACT  
101.  REQ  
102. **** > 

Main Extraction – Option11x Systems 
1. LD 2 . 
2. TTAD . 
3. **** > 
4. LD 22 REQ 
5. ISS REQ 
6. TID REQ 
7. SLT REQ 
8. PRT TYPE 
9. PKG REQ 
10. PRT TYPE 
11. CFN REQ 
12. PRT TYPE 
13. CINV REQ 
14. or1... TYPE 
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15. end or1 
16. **** > 
17. LD 97 > 
18. or1... REQ 
19. PRT TYPE 
20. SUPL TYPE 
21. or2... vblfSUPL 
22.   REQ 
23. PRT TYPE 
24. end or2 
25. XPE TYPE 
26. or2... XPEC 
27.  REQ 
28. end or2 
29. end or1 
30. **** > 
31. LD 32 . 
32. IDCunconfig . /* cards having unconfigured unit (detected in LUU500/20 
33. **** > 
34. LD 32 . 
35. IDCforIPE . /* IPE cards + SDI/DCH eventually (detected in CEQ 
36. **** > 
37. LD 32 . 
38. IDC 4 . 
39. **** > 
40. LD 32 . 
41. Idle NPR506 
42. or1... . 
43. Disabled . 
44. Busy . 
45. Idle . 
46. Disabled . 
47. Busy . 
48. Idle . 
49. Disabled . 
50. Busy . 
51. Idle . 
52. Disabled . 
53. Busy . 
54. end or1 
55. **** > 
56. LD 81 REQ 
57. CNT CUST 
58. CustNo DATE 
59.  PAGE 
60.  DES 
61.  FEAT 
62. ACD FEAT 
63. SETS FEAT 
64. DTA FEAT 
65. DCFW FEAT 
66. WRLS FEAT 
67. VCE FEAT 
68. FLXA FEAT 
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69. AGTA FEAT 
70. VMA FEAT 
71. CNUA FEAT 
72. CNUS FEAT 
73. Visitors FEAT /* VSIT or blank if feat370 missing 
74. or1... HMDN 
75.  FEAT 
76. end or1 
77.  NACT 
78.  REQ 
79. END > 
80. LD 20 REQ 
81. LUC REQ 
82. LUU REQ 
83. or1... TYPE 
84. 500 TN 
85.  REQ 
86. or2... CDEN 
87.  REQ 
88. end or2 
89. Unconfig TYPE /* LUU (rls>19) or LUVU 
90. 2000 TN 
91.  REQ 
92. end or1 
93. PRT TYPE 
94. ATT TYPE 
95. or1... TN 
96.  CUST 
97.  DATE 
98.  PAGE 
99.  REQ 
100. or2... NACT 
101.  REQ 
102. end or2 
103. PRT TYPE 
104. end or1 
105. 1250 TYPE 
106. or1... TN 
107.  CUST 
108.  DATE 
109.  PAGE 
110.  REQ 
111. or2... NACT 
112.  REQ 
113. end or2 
114. PRT TYPE 
115. end or1 
116. 2250 TYPE 
117. or1... TN 
118.  CUST 
119.  DATE 
120.  PAGE 
121.  REQ 
122. or2... NACT 



Command Scripts 

B–6   OrderPro User’s Guide v6.0    

123.  REQ 
124. end or2 
125. PRT TYPE 
126. end or1 
127. PWR TYPE 
128. or1... TN 
129.  DATE 
130. or2... CDEN 
131.  DATE 
132. end or2 
133.  PAGE 
134.  REQ 
135. or2... NACT 
136.  REQ 
137. end or2 
138. end or1 
139. **** > 
140. LD 83 REQ 
141. LST CUST 
142.  DATE 
143.  PAGE 
144.  NACT 
145.  REQ 
146. END > 

Main Extraction – Large Systems 
1. LD 2 . 
2. TTAD . 
3. **** > 
4. LD 22 REQ 
5. ISS REQ 
6. TID REQ 
7. SLT REQ 
8. PRT TYPE 
9. PKG REQ 
10. PRT TYPE 
11. CFN REQ 
12. **** > 
13. LD 97 > 
14. or1... REQ 
15. PRT TYPE 
16. SUPL TYPE 
17. or2... vblfSUPL 
18.   REQ 
19. PRT TYPE 
20. end or2  
21. XPE TYPE 
22. or2... XPEC 
23.  REQ 
24. end or2  
25. end or1  
26. **** > 
27. LD 32 . 
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28. IDCunconfig . /* cards having unconfigured unit (detected in LUU500/2000 commands) 
29. **** > 
30. LD 32 . 
31. IDCS . 
32. **** > 
33. LD 32 . 
34. STAT PER 0 . 
35. STAT PER 1 . 
36. STAT PER 2 . 
37. STAT PER 3 . 
38. STAT PER 4 . 
39. STAT PER 5 . 
40. STAT PER 6 . 
41. STAT PER 7 . 
42. STAT PER 8 . 
43. STAT PER 9 . 
44. STAT PER 10 . 
45. STAT PER 11 . 
46. STAT PER 12 . 
47. STAT PER 13 . 
48. STAT PER 14 . 
49. STAT PER 15 . 
50. **** > 
51. LD 81 REQ 
52. CNT CUST 
53. CustNo DATE 
54.  PAGE 
55.  DES 
56.  FEAT 
57. ACD FEAT 
58. SETS FEAT 
59. DTA FEAT 
60. DCFW FEAT 
61. WRLS FEAT 
62. VCE FEAT 
63. FLXA FEAT 
64. AGTA FEAT 
65. VMA FEAT 
66. CNUA FEAT 
67. CNUS FEAT 
68. Visitors FEAT /* VSIT or blank if feat370 missing 
69. or1... HMDN 
70.  FEAT 
71. end or1  
72.  NACT 
73.  REQ 
74. END > 
75. LD 20 REQ 
76. LUC TN 
77.  REQ 
78. LUU REQ 
79. or1... TYPE 
80. 500 TN 
81.  REQ 
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82. or2... CDEN 
83.  REQ 
84. end or2  
85. Unconfig TYPE /* LUU (rls>19) or LUVU 
86. 2000 TN 
87.  REQ 
88. end or1  
89. PRT TYPE 
90. ATT TYPE 
91. or1... TN 
92.  CDEN 
93.  CUST 
94.  DATE 
95.  PAGE 
96.  REQ 
97. or2... NACT 
98.  REQ 
99. end or2  
100. PRT TYPE 
101. end or1  
102. 1250 TYPE 
103. or1... TN 
104.  CUST 
105.  DATE 
106.  PAGE 
107.  REQ 
108. or2... NACT 
109.  REQ 
110. end or2  
111. PRT TYPE 
112. end or1  
113. 2250 TYPE 
114. or1... TN 
115.  CUST 
116.  DATE 
117.  PAGE 
118.  REQ 
119. or2... NACT 
120.  REQ 
121. end or2  
122. PRT TYPE 
123. end or1  
124. PWR TYPE 
125. or1... TN 
126.  DATE 
127. or2... CDEN 
128.  DATE 
129. end or2  
130.  PAGE 
131.  REQ 
132. or2... NACT 
133.  REQ 
134. end or2  
135. end or1  
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136. **** > 
137. LD 83 REQ 
138. LST CUST 
139.  DATE 
140.  PAGE 
141.  NACT 
142.  REQ 
143. END > 
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C 
ISM Extraction Calculation 

This appendix describes the methods used for calculating the values for the new ISM 
parameters.  
Many of the data items extracted from the Meridian 1 system are used for more than 
calculating the ISM values. The appendix describes the data items that are relevant to 
ISM parameters only. 

Note: This section assumes you are familiar with Meridian 1 overlays and 
their output. 

 

ISM Extraction - Calculation 
Detail taken from the Meridian 1 System 

Initial extraction 

Overlay Item Used for 

LD 22 ISS Identifying machine type and software release. This is used to 
determine which Pre-extraction script to use and also which 
commands to use where differences exist between system types 
and software releases. 

Pre-extraction  

LD 97 XPEC To establish IPE shelves configured ready for IDCS command 
in main extraction. 

LD 20 LUC To establish unused card slots (small systems only) 

LD 20 LUU To establish which cards have unused units ready for specific 
IDC commands in main script 

LD 22 PKG 370 To establish existence of Wireless visitors to control main 
extraction input re this feature 

LD 22 CEQU To establish main system configuration parameters (small 
systems only) 

LD 32 Lxxx To establish number of Option 11 cabinets installed (small 
systems only) 

LD 81 SETS To establish multi customer set usage 

Main extraction 
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LD 2 TTAD Date and time of extraction 

LD 22 ISS System generic and software release 

LD 22 TID Identifying system ID number. This is used for system 
reference purposes. 

LD 22 SLT Identifying existing system limits and ISM values (TN level, 
ACD DN etc). Some of the values here maybe used when 
providing the final ISM parameters. 

LD 22 PKG Identifying all of the existing software features in the system.  
One of the functions of OrderPro is to establish the correct 
software packaging for any upgrades. 

LD 22 CFN The system configuration print is used to identify various items 
that are configured in the system. 

LD 22 CINV Establish core hardware (small systems only) 

LD 97 SUPL Identifying the superloops configured in the system. 

LD 97 XPE Identifying the IPE shelves fitted in the system 

LD 32 IDC x Cards with unconfigured units only 

LD 32 IDC x All IPE cards (small systems only) 

LD 32 IDC 4 For Identification of 48 port line card (small systems only) 

LD 32 IDCS x All IPE cards (large systems only) 

LD 32 STAT 
PER 

Establish number of configured Network shelves (large systems 
only) 

LD 32 Lxxx Establish number of Option 11 cabinets (small systems only) 

LD 81 CNT This is used to provide a count of several configured software 
items in the system. The output from this is manipulated to give 
the new ISM parameters together with other items of 
information (spare cards, spare slots etc..) 
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LD 20 LUC List all unused card slots  

LD 20 LUU List all unused units 

LD 20 ATT 

1250 

2250 

PWR 

To establish quantity of ports used for Operator Console 
functions 

LD 83 LST This gives a list of all configured sets. Used for various 
purposes. 
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Calculation of ISM Values 
ISM values that are defined by OrderPro will either be read from the relevant value in 
the LD 22 SLT print or calculated based on information gathered in the LD 81 count. 
Other data collected from the system will be used to make adjustments when providing 
the final ISM values. 
The following is an example LD 81 print. Column and row references have been added 
in red purely for ease of identification. 
Not all rows and or columns will be printed for all systems as this will depend on exact 
software release and feature content. These figures will exist for each customer in a 
multi customer system, with all values being added together to provide the final 
calculations. 
Example CNT matrix and calculations: 
    A B C D E F G H I J 

 FEAT Cust  TOTAL SL1 500 2500 3000 4020 2000 3900 ISET DCS 

1 ACD 00 CNT 63 24 0 6 0 0 29 0 4 0 

2 SETS 00 CNT 328 41 0 221 0 0 58 0 8 0 

3 DTA 00 CNT 26 12 0 0 0 0 14 0 0 0 

4 VCE 00 CNT 302 29 0 221 0 0 44 0 8 0 

5 VMA 00 CNT 24 24 0 0 0 0 0 0 0 0 

6 AGTA 00 CNT 6 0 0 6 0 0 0 0 0 0 

7 DCFW 00 CNT 143 0 0 143 0 0 0 0 0 0 

8 WRLS 00 CNT 36 0 0 28 0 0 0 0 0 8 

9 FLXA 00 CNT 2 0 0 0 0 0 2 0 0 0 

10 CNUA 00 CNT 7 0 0 7 0 0 0 0 0 0 

11 CNUS 00 CNT 13 0 0 13 0 0 0 0 0 0 

12 VSIT 00 CNT 5 0 0 0 0 0 0 0 0 5 

Note: 

Changes are made to the table as it has been experienced that not all of the values are printed. 
This is identified by A4 having a value of zero. 

IF A4 = 0 

 B4 = B2 – B3 

 C4 = C2 – C3 

 D4 = D2 – D3 

 Etc…to 

 J4 = J2 – J3 

 A4 = A2 – A3 

END IF 
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The following shows calculations made from the LD 81 CNT matrix prior to any further 
manipulation ready for final output. 

Item From output 

Digital voice sets B4 + E4 + F4 + G4 + H4 – B1 – E1 – F1 – G1 – H1 

Digital ACD sets B1 + E1 + F1 + G1 + H1 – A5 

Mail Agents    A5 

Analogue sets  C2 + D2 - A6 - C8 - D8 

Analogue ACD sets   A6 

Data sets   A3 

Analogue wireless sets         C8 + D8 

CLASS sets    A10 + A11 

Wireless visitors                        A12 

DCS wireless sets  J8 

IP sets   I4 

IP ACD agents   I1 

Additional items calculated by OrderPro that may be used in the final output are: 

•  Digital phantom sets 

•  Analogue phantom sets 

•  Un-configured ports on digital line cards 

•  Un-configured ports on analogue line cards 

•  Un-configured ports on wireless cards 

All systems need to take the phantom sets into account, but the inclusion of unconfigured ports 
will be region specific according to the rules tables that are shown later. 

Further to these calculations, the user will also be given the option to include spare card slots or 
unallocated TN’s from the existing system in the ISM value that they will receive with the 
upgrade to Succession release 3. 

 

    Calculated items prior to final adjustment according to region specific rules and user adjustment 

ISM digital Digital Voice sets + Digital ACD sets - Digital Phantoms 

ISM analogue Analogue sets + Analogue ACD sets - Class sets - Analogue Phantoms 

ISM ACD agents Digital ACD sets + Analogue ACD sets + IPset ACD 

ISM Wireless Analogue wireless sets + DCS wireless + Spare Wrls 

ISM Internet telephones IP sets 

ISM Class Class sets 

ISM Visitors Wireless visitors 
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Region specific rules 
The following tables show the rules that are being applied to existing systems when 
upgrading to Succession release 3. 

Rules to apply for US systems 
When calculating ISM values for upgrade to Succession 3.0 in the US, these are the rules that 
will be applied. 

ISM Method (all systems unless stated) Notes 

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Use calculated method without unconfigured units.  

Add left TN from SLT print according to user  

selection. 

 

Wireless telephone Use calculated method without unconfigured units  

Internet  Telephone 
If rls = 25.15+ use “Available” value from SLT print, 

else default 
 

Wireless Visitor Use “Available” from SLT print or default value Note 4 

ACD Agents 
If rls = 17+ use “Used” value from SLT print,  

else calculated method 

Opt 11C/11C mini  

only 

ACD Agents 
If rls = 17+ use “Available” value from SLT print,  

else calculated method 
Large systems only 

PCA Use “Available” from SLT print or default value Note 4 

AST 
If rls = 17+ use “Used” from SLT, else use  

ACD agent value 

Opt 11C/11C mini  

only  

AST 
If rls = 17+ use “Available” from SLT, else use  

ACD agent value 

Large systems only 

 

IP Peer H323 Trunks Use “Available” from SLT print or default value Note 4 

ITG ISDN Trunks 
If gen 2111 use “Used” from SLT rounded to 8,  

else default value 
 

ITG ISDN Trunks 
If large system at 25.15 +, use value from ITG card  

Calculation, else default 
Note 1 

RAN Con 

MUS Con 
If rls = 23+ use “Used” from SLT, else default value 

Opt 11C/11C mini  

only 

RAN Con 

MUS Con 

If rls = 23+ use “Available” from SLT, else default  

value 
Large systems only 

Survivability If rls = 25.30+ use “Available” from SLT, else default  

All Others Not calculated by Order pro, value is set in Order Tool  
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Rules to apply for Canadian systems 
When calculating ISM values for upgrade to Succession 3.0 in Canada, these are the rules that 
will be applied. 

ISM Method (all systems unless specified) Notes 

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Use calculated method without unconfigured units 

Add left TN from SLT print according to user  

selection. 

 

Opt 11C/11C mini  

only  

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Use calculated method and include unconfigured  

units 

Large 

Systems only 

Wireless telephone Use calculated method without unconfigured units Opt 11C/11C mini 
only 

Wireless telephone Use calculated method and include unconfigured units Large Systems only 

Internet  Telephone If rls = 25.15+ use “Available” value from SLT print, 
else default 

 

Wireless Visitor  Use “Available” from SLT print or default value Note 4 

ACD Agents If rls = 17+ use “Used” value from SLT print, else use 
calculated method 

Opt 11C/11C mini 
only 

ACD Agents Use calculated method Large Systems only 

PCA  Use “Available” from SLT print or default value Note 4 

AST If rls = 17+ use “Used” from SLT, else use ACD agent 
value 

Opt 11C/11C mini 
only   

AST If rls = 17+ use “Available” from SLT, else use ACD 
agent value 

Large Systems only  

IP Peer H323 Trunk Use “Available” from SLT print or default value Note 4 

ITG ISDN Trunk If gen 2111 use “Used” from SLT rounded to 8,  else 
default value 

 

ITG ISDN Trunk If large system at 25.15 +, use value from ITG card 
Calculation, else default 

Note 1 

RAN Con 

MUS Con 

If rls = 23+ use “Used” from SLT, else default value Opt 11C/11C mini 

only 

RAN Con 

MUS Con 

If rls = 23+ use “Available” from SLT, else default 
value 

Large Systems only 

Survivability If rls = 25.30+ use “Available” from SLT, else default 
value 

 

All Others Not calculated by Order pro, value is set in Order Tool  
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Rules to apply for CALA systems 
When calculating ISM values for upgrade to Succession 3.0 in CALA, these are the rules that 
will be applied. 

It has been found that some CALA systems have been provided with US software packaging 
and if software PKG 131 (SUPP) does not exist in a CALA selected system then use US rules. 

 

ISM Method (all rls/system unless specified) Notes 

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Use calculated method and include unconfigured  

units 

Rls 25.30 and earlier

 

 

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Use calculated method without unconfigured units 

Add left TN from SLT print according to user  

selection. 

Later than 25.30  

Note 3 

 

Wireless telephone Use calculated method and include unconfigured  

units 

Rls 25.30 and earlier

Wireless telephone Use calculated method without unconfigured units Later than 25.30 

Internet Telephone If rls = 25.15+ use “Available” value from SLT print,  

else default 

 

Wireless Visitor Use “Available” from SLT print or default value Note 4 

ACD Agents If rls = 17+ use “Used” value from SLT print,  

else calculated method 

All systems 

PCA Use “Available” from SLT print or default value Note 4 

AST If rls = 17+ use “Used” from SLT, else use 

ACD agent value 

All systems  

IP Peer H323 Trunk Use “Available” from SLT print or default value Note 4 

ITG ISDN Trunks If rls = 25.10+ use “Available” from SLT, else  

default value 

All systems 

RAN Con 

MUS Con 

If rls = 23+ use “Used” from SLT, else default value All systems 

Survivability If rls = 25.30+ use “Available” from SLT, else  

default value 

 

All Others Not calculated by Order pro, value is set in Order Tool  
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Rules to apply for EMEA systems 
When calculating ISM values for upgrade to Succession 3.0 in EMEA, these are the rules that 
will be applied to pre FBP systems. 

ISM Method  Notes 

Analog Telephone 

CLASS Telephone 

Digital Telephone 

Wireless telephone 

ACD Agents 

Use calculated value including unconfigured units on  

digital and analogue cards. 

 

Internet Telephone Use “Available” from SLT print or default value  

Wireless Visitor If Pre 25.40 then calculate else use SLT “Available”  

PCA Use “Available” from SLT print or default value Note 4 

AST If rls = 17+ use “Used” from SLT, else use ACD agent 
value 

Note 2 

IP Peer H323 Trunk Use “Available” from SLT print or default value Note 4 

ITG ISDN Trunks Use “Available” from SLT print or default value  

RAN Con 

MUS Con 

Use “Available” from SLT print or default value  

Survivability Use “Available” from SLT print or default value Small systems only 

Brandline Use “Available” from SLT print or default value 

LTID (ISDN BRI) Use “Used” from SLT print or default value 

TMDI D-channel Use “Used” from SLT print or default value 

 

All Others Not calculated by Order pro, value is set in Order Tool  

For EMEA, a system is defined as FBP/pre FBP according to: 

Country usage Condition Status 

FBP introduced on rls 24 System is pre rls 24 Pre FBP 

FBP introduced on rls 24 System is rls 24 or later FBP 

FBP introduced on rls 25 System is pre rls 25 Pre FBP 

FBP introduced on rls 25 System is rls 25 or later FBP 

CIS and Israel System is rls 25 and analogue, digital, wireless, 
ACD agents are all maxed out (2500 on small 
systems, 32767 on large systems) 

Pre FBP 

 

 

When Order Pro is run on systems in EMEA that are already on FBP, no .opi file will be 
generated. All of the ISM values listed above will have their “Available” and “Used” values 
printed in the Summary report. 
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Rules to apply for APAC systems 
When calculating ISM values for upgrade to Succession 3.0 in APAC, these are the rules that 
will be applied to pre FBP systems. 

ISM Method  Notes 

Analog Telephone 

Digital Telephone 

Wireless telephone 

ACD Agents 

Use calculated value including unconfigured  

units on digital and analogue cards. 

 

Rls 24.20 and earlier

Analog Telephone 

Digital Telephone 

Use “Available” from SLT print or calculated value 

 if not printed in SLT (maxed out) 

Wireless telephone  For Rls 25.15 and 25.30 use “Available” value from 

SLT print minus the calculated Wireless Visitors. 

Otherwise use the “Available” value from SLT print. 

ACD Agents  Use “Available” from SLT print or default value 

Later than Rls 24.20 

  

CLASS Telephone Calculate if pre rls 25 else use “Used” value from  

SLT print 

 

Internet Telephone Use “Available” from SLT print or default value  

Wireless Visitor If Rls 25.15 or 25.30 then calculate else use SLT  

“Available” 

 

PCA Use “Available” from SLT print or default value Note 4 

AST If rls = 17+ use “Used” from SLT, else use ACD  

agent value 

Note 2 

IP Peer H323 Trunk Use “Available” from SLT print or default value Note 4 

ITG ISDN Trunks Use “Available” from SLT print or default value  

RAN Con 

MUS Con 

Use “Available” from SLT print or default value  

Survivability Use “Available” from SLT print or default value Small systems only 

   

Brandline Use “Available” from SLT print or default value 

LTID (ISDN BRI) Use “Used” from SLT print or default value 

TMDI D-channel Use “Used” from SLT print or default value 

 

All Others Not calculated by Order pro, value is set in Order Tool  
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For APAC, a system is defined as FBP/pre FBP according to: 

S/ware rls Condition Status 

Pre 25.30 None Pre FBP 

25.30 – Australia/New Zealand If AST “Available” = 5000 Pre FBP 

25.30 – Australia/New Zealand If AST “Available” < 5000 FBP 

25.30 – all other countries None FBP 

25.40 – small systems If CLASS “Available” = 2500 Pre FBP 

25.40 – large systems If CLASS “Available” = 32767 Pre FBP 

25.40 – small systems If CLASS “Available” < 2500 FBP 

25.40 – large systems If CLASS “Available” < 32767 FBP 

 

When Order Pro is run on systems in APAC that are already on FBP, no .opi file will be 
generated. All of the ISM values listed above will have their “Available” and “Used” values 
printed in the Summary report. 

Both the “Available” and “Used” values in the summary report for Wireless telephones will be 
minus the calculated Wireless Visitors (rls 25.15 and 25.30). 

 

Notes (applicable to all rules tables) 

1. The ITG card calculation method looks for cards that can support 
ITG ISDN trunks as well as the number of trunks supported on each 
card. The output is the total ITG ISDN trunks that can be supported 
on the hardware installed in the system. 

2. The AST value is new to the EMEA market and was not previously 
calculated by Orderpro 

3. A capping rule must be applied to large systems in CALA at 
software level later than 25.30. This will equate to a maximum 
system usage of 2000 TN for each network group. 

4. The values are expected to be at 0, but may be used in beta 
Succession 3.0 systems. Order Pro will provide the higher of the 
“Available” and Default values” 
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Addition requirements in ISM calculations 
Where ISMs will be sold in multiples of 8, the value included in the .opi file will be rounded up 
to the nearest 8. This applies to ISM for: 

•  Analogue + Wired for Analogue 
•  Digital + Wired for Digital 
•  CLASS 
•  Wireless 
•  Wireless Visitors 
•  ITG ISDN Trunks 

 

The term “Wired for” is used to define ISM parameters that exist in a system without having 
the supporting hardware. According to region, the user will be offered the option to include 
either spare IPE card slots or unused TNs to the final ISM value. 

This will be done according to the following: 

 

Region Upgrade from Option to user “Wired for” allocated 

US All systems,  

all releases. 

Canada Small systems,  

all releases. 

CALA All systems at  

release 25.30  

and later 

Allocate a quantity of the “Left TN” value to 
either “Wired for Analogue” or “Wired for 
Digital”. 

The amount allowed to be allocated is from 0 
to the “Left TN” value 

Allocated as per user 
choice. 

The total of calculated and
wired for analogue and 
digital users will each be 
rounded up to the nearest 
multiple of 8. 

CALA systems without 
PKG 131 will be treated 
as US systems. 

Canada Large systems,  

all releases. 

CALA All systems at  

pre release 25.30 

EMEA Pre FBP 

Allocate a quantity of the “Spare IPE slots”  

to either “Wired for Analogue” or “Wired  

for Digital”. 

The amount allowed to be allocated is from 

0 to the value of “Spare IPE slots” 

Allocated as per user  

choice. 

CALA systems without 

PKG 131 will be treated  

as US systems. 

EMEA FBP None No 

APAC Pre rls 24B Allocate a quantity of the “Spare IPE slots” 

to either “Wired for Analogue” or “Wired  

for Digital”. 

The amount allowed to be allocated is from  

0 to the value of “Spare IPE slots” 

Allocated as per user  

choice 

APAC Rls 24B and later None No 
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Values from SLT print 
In several cases the values used to provide new ISM values are taken from the SLT 
print.  
The following is an example print with the first column of figures being the Available 
value. 
Please note that the print out of these figures are controlled by software release, 
software control and feature packaging, thus not all lines will appear on all systems.  
TNS 32767 LEFT 32270 USED 497 

ACD AGENT 15 LEFT 3 USED 12 

ACDN 24000 LEFT 23860 USED 140 

AST 500 LEFT 490 USED 10 

LTID 10000 LEFT 10000 USED 0 

DCH 63 LEFT 59 USED 4 

AML  16 LEFT 12 USED 4 

MPH DSL 100 LEFT 100 USED 0 

RAN CON 150 LEFT 150 USED 0 

RAN RTE 511 LEFT 511 USED 0 

MUS CON 150 LEFT 150 USED 0 

ANALOGUE TELEPHONE 10000 LEFT 9956 USED 44 

BRI DSL 10000 LEFT 9992 USED 8 

CLASS TELEPHONES 100 LEFT 50 USED 50 

DIGITALTELEPHONES  10000 LEFT 9925 USED 75 

WIRELESS TELEPHONES 100 LEFT 44 USED 56 

WIRELESS VISITORS 5000 LEFT 5000 USED 0 

ATT. CONSOLES 10 LEFT 10 USED 0 

DATA PORTS 2500 LEFT 2481 USED 19 

PHANT. PORTS 2500 LEFT 2494 USED 6 

TRAD. TRKS. 2500 LEFT 2370 USED 130 

ITG ISDN TRUNKS 2500 LEFT 2500 USED 0 

INTERNET TELEPHONES 10 LEFT 10 USED 0 

TMDI DCH 0 LEFT 0 USED 0 

SURVIVABILITY 2 LEFT 1 USED 1 

BRAND 1 LEFT 0 USED 1 
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Default values 
Default ISM values are those that would apply to a system where the feature is not 
purchased, and within the various rule sets for upgrading, these would be applied in 
the case where the feature does not exist on the current system. 
For reference, these are the default values that would be applied to ISM values by 
OrderPro: 

Default values 
ISM 

Option 11c Option 11c mini Large systems 
Note 

Analog Telephone 0 0 0  

CLASS Telephone 0 0 0  

Digital Telephone 0 0 0  

Wireless telephone 0 0 0  

Internet Telephone 0 0 0  

Wireless Visitor 0 0 0  

ACD Agents 10 10 10  

PCA 0 0 0 New in CSE 3.0 

AST 0 0 0  

ITG ISDN Trunks 0 0 0 M1 only in CSE 3.0 

IP Peer H323 Trunks 0 0 0 New ISM for CSE 3.0 

RAN Con 0 0 0  

MUS Con 0 0 0  

Survivability 0 0 n/a  

TNs 2500 2500 32760  

ACDN 300 300 24000  

AML n/a n/a 16  

Brand 2 2 2  

LTID 0 0 32760  

RAN route 500 500 512  

Att. Consoles 2500 2500 32760  

BRI DSL 150 150 10000  

MPH DSL n/a n/a 64  

Data ports 2500 2500 32760  

Phantom ports 2500 2500 32760  

Trad trunks 2500 2500 32760  

DCH n/a n/a 254  

TMDI Dchannel 64 64 n/a  
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D 
Suppressing Error Messages 

Error codes and other information can be returned from the Meridian 1 during login 
sessions, which may be of unknown length and format. The items include: 
TIMXXX, DTCXXX, TRKXXX, IODXXX, BUGXXX 

Other items could include Traffic Measurement and CDR reports, as well as 
background terminal messages. 
These error messages can have two types of impact on the process: 
 Extraction failure: if an error message is sent by the system in the middle of an 

expected prompt, the OrderPro extraction will hang. In this event, you need to 
cancel the process (by clicking the Cancel button) and begin a new extraction. It is 
very unlikely that this problem will reoccur in subsequent second extraction. 

 Loading failure: If errors have been reported in the Log file, OrderPro can not 
guarantee that all of the error messages will be removed and this may result in a 
loading failure. In this case, OrderPro issues a loading failure message to the user 
and manual manipulation of the Log file is required to remove outstanding error 
messages. 

The output will vary from system to system according to configuration. Most 
configuration variances can be removed by identifying the TTY port used and 
changing the configuration for message output during the extraction. The configuration 
would have to be restored after the extraction to ensure a subsequent valid extraction 
and loading process. 
As an extraction tool, OrderPro does not modify any configuration on a system by 
itself. If any such manipulation is required during the extraction, it has to be performed 
by the user. The description of the commands to run is detailed below. 

Identifying the TTY port used and the configuration. 
On connection to the system and prior to login, enter <cr>, response will be: 
 
OVL111 000 IDLE    

 

TTY 00 SCH MTC BUG CTY   12:44 

 
This output displays the TTY number (00 upwards) and user class (SCH, MTC, BUG 
and CTY). The user class may include others but will always be 3 characters. 
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Note: one option on the TTY is for background terminal (BGD). This will not give the 
information required and will just return a "." after <cr>. To get the required 
information, enter  *<cr>. 
If *<cr> is used on a non-background terminal, then the response is given twice. The 
option is available to accept this on all systems, or always enter <cr> and only enter 
*<cr> if a "." is seen. 
 
Example with BGD configured: 
.* 

OVL111 000 IDLE 

 

TTY 00 SCH MTC BUG BGD  CUST 00 - 0   12:47 

 
The BGD function is also allocated to a Meridian 1 customer, so ignore CUST and the 
numbers that follow. 

To disable error message reporting: 
After login to the system - 
LD 17 

>ld 17 

Prompt Command 
REQ   chg 

TYPE  adan 

ADAN  chg tty X   Where X = TTY number identified 

TTY_TYPE SDI    these lines are an auto print from  

CAB 00     the system. IGNORE any prints until 

CDNO 00     the prompt DES appears. Enter <cr> 

PORT 0     to each prompt until USER appears. e.g. 
DES   <cr> 

FLOW  <cr> 

ENL   <cr> 

USER  Xabc  

where abc is the code returned after the TTY number prior to login. Enter Xabc for all codes 
except for SCH. Each entry is separated by a space with all being on one line followed by 
<cr> 
TTYLOG  <cr> 

BANR  <cr> 

 

The following sample output will be displayed: 
MEM AVAIL: (U/P): 461904    USED: 127919    TOT: 589823  
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DCH  AVAIL:    60    USED:     4    TOT:    64 

AML  AVAIL:    15    USED:     1    TOT:    16 

 

ADAN DATA CHGED 

ADAN  END  enter this to exit overlay 

To re-enable error message reporting: 
Follow the steps to disable error message reporting, but enter the 3-digit code as it is 
without the X in front for all codes that have been removed. 
Note: The exact prompts given by the system while doing this will not be the same. 
The software release, software feature, and hardware type (for TTY port) will 
determine what prompts are displayed. 
You will need to wait for a prompt and enter <cr> until the prompts you require 
(USER) are displayed. 
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E 
CVSD structure  

 Asia Pacific Region - Service Level Content 
The features in the table below are included automatically in the appropriate service level 
for ALL machine types and ALL countries in the region when the Service ISMs for the 
service level are Ordered for New Systems and on Upgrade to Succession 3.0 from a 
previous release. 

 

Level  4  Premium Network Services NTE935AA – A511529 

     207, 321, 
 

Level 3A  Advanced Call Centre Services 

NTE933AA – A0511531 

 50, 114, 155, 225, 297, 311,388 

Level  3B  Advanced Network Services 

 NTE934AA – A0511530 

37, 38, 39, 62, 67, 159, 175, 183, 188, 192, 219, 231, 305, 
313, 316, 335, 348, 370  

Level  2   Enhanced Business Service  NTE932AA – A0511532 

  2, 42, 43, 60, 63, 86, 116, 118, 123, 147, 148, 149,152, 172, 178  

  209, 263, 306, 307, 309, 312, 351, 382, 387, 394, 399  
 

Level  1   Business Services   NTE931AA – A0511533 

 

0, 1, 4, 5, 7, 8 ,9, 10, 11, 12, 13, 14, 16, 17, 18, 19, 20, 21, 23, 24, 25, 28, 29, 32, 33, 34, 35, 36, 40, 41, 
44, 45, 46,47, 48, 49, 51, 52, 53, 54, 55, 56,  58, 59, 61, 64, 70, 71, 72, 73, 74, 75, 76, 77, 79, 80, 81, 83, 
87, 88, 89, 90, 91, 92, 93, 95, 98, 99, 100, 101, 102, 103, 104, 105, 107, 108, 109, 110, 111, 113, 115, 
117, 119, 120, 122, 124, 125, 127, 128, 129, 132, 133, 134, 137, 138, 139, 140, 141, 144, 145, 146, 150, 
151, 153, 154, 157, 160, 161, 162, 163, 164, 167, 169, 170, 173, 174, 179, 180, 181, 182, 184, 185, 186, 
187, 191, 193, 195,198, 202, 203, 204, 205, 206, 208, 210, 211, 212, 214, 215, 216, 218, 222, 229, 233, 
234, 235, 236, 240, 242, 243, 245, 246, 247, 250, 251, 253, 254, 255, 256, 258, 259, 261, 283, 289, 294, 
296, 301, 308, 310, 315, 323, 324, 327, 328, 332, 333,.347,.349, 350, 362, 364, 380, 381, 384, 386, 389,  
397, 398  
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DEFAULT FEATURES FOR ASIA PACIFIC – the following features will automatically 
be added to New System or Upgrade Keycodes when the conditions are met: 

65 –TDET - for all countries in AP in L1 for all Large systems 
200 & 295 – for all countries – in Level 1 – for all 11C & 1000M chassis & cabinet & 
Succession 1000 
227, 228, 286, & 368:  for all countries – in Level 1 – for all Option 61C & 1000M SG 
227, 228, 286, 368, 365 & 299: for all countries – in Level 1 for all Option 81C & 1000 M MG 
227, 228, 286, 298 & 365:  for all countries – in Level 1 for all Option 81s upgrading 
227, 228, & 286: for all countries – in Level 1 for Option 51Cs upgrading  
 

97 – JCO – for Japan – in Level 1 for all large and small systems except Succession 1000 
121 – SCMP –for Japan – in Level 1 for all system types 
136 – JDMI – for Japan – in Level 1 for Large Systems only 
171 – JTDS – for Japan – in Level 1 for all large and small systems except Succession 1000 
196 – OHOL - for Japan – in Level 1 for  all system types 
126, 285 & 292 – OPCB, CHINA, CHTL  – for China – in L1 for all larg &small 
systems except  Succession 1000 
288 – DPNSS-ES - – for AP and China (is na for Japan) – in Level 3b for all system types 
131 – SUPP – for AP and China – in Level 1 for all system types  
284 – DPNSS 1891 – for AP and China (is na for Japan) – in Level 3b for all system types 
325 – DMWI - for AP and China (is na for Japan) – in Level 4 for all system types 
 

OPTIONAL FEATURES FOR ASIA PACIFIC – the following features will be added to 
the upgrade keycode automatically if the system upgrading has the feature in LD22 or on 
New Systems if the Order Code for the feature is ordered.  

 

15 – RPE1.5 - for all countries in AP - can be added to any level for Large Systems 
22 – DISA – for all countries in AP - can be added to any level for any system types 
57 – BARS – for all countries in AP - can be added to any level for any system types 
165 – RPE2 – for all countries in AP except Japan - can be added to any level for Large 
systems  
121 – SCMP – for AP & China – can be added to any level for any system type 
131 – SUPP – For Japan only – can be added to any level for any system type 
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 CALA Region - Service Level Content 
 

The features in the table below are included automatically in the appropriate service level 
for ALL machine types and ALL countries in the region when the Service ISMs for the 
service level are Ordered for New Systems and on Upgrade to Succession 3.0 from a 
previous release 

 

Level  4    Premium Network Services  NTE925AA – A0511524 

     207, 321, 325 
 

Level  3A  Advanced Call Centre Services 

NTE923AA – A0511526 

 50, 114, 155, 224, 225, 249, 297, 311, 388, 
393 

 

Level  3B  Advanced Network Services 

NTE924AA – A0511525 

37, 38, 39, 62, 67, 158, 159, 175, 183, 188, 

 192, 219, 231, 262, 284, 288, 305, 316, 348, 

 

Level  2    Enhanced Business Services  NTE922AA – A0511527 

  2, 26, 27, 42, 43, 60, 63, 86, 116, 118, 123, 147, 148, 149, 152, 172, 178  

  209, 263, 306, 307, 309, 312, 331, 334, 351, 367, 382, 385, 387, 394, 399 

 

Level  1   Business Services   NTE921AA – A0511528 

0, 1, 4, 5, 7, 8 ,9, 10, 11, 12, 13, 14, 16, 17, 18, 19, 20, 21, 23, 24, 25, 28, 29, 32, 33, 34, 35, 36, 
40, 41, 44, 45, 46, 47, 48, 49, 51, 52, 53, 54, 55, 56,,57,  58, 59, 61, 64, 70, 71, 72, 73, 74, 75, 76, 
77, 79, 80, 81, 83, 87, 88, 89, 90, 91, 92, 93, 95, 98, 99, 100, 101, 102, 103, 104, 105, 107, 108, 
109, 110, 111, 113, 115, 117, 119, 120, 122, 124, 125, 126, 127, 128, 129, 131, 132, 133, 134, 
135,137, 138, 139, 140, 141, 143, 144, 145, 146, 150, 151, 153, 154, 157, 160, 161, 162, 163, 164, 
167, 169, 170, 173, 174, 179, 180, 181, 182, 184, 185, 186, 187, 189, 191, 193, 195, 196, 198, 
202, 203, 204, 205, 206, 208, 210, 211, 212, 214, 215, 216, 218, 222, 223, 229, 232, 233, 234, 
235, 236, 240, 242, 243, 245, 246, 247, 250, 251, 253, 254, 256, 258, 259, 261, 283, 289, 290, 
291, 294, 296, 301, 308, 310, 315, 323, 324, 327, 328, 329,330, 332, 333, 350, 362, 364, 380, 381, 
384, 386, 389, , 397, 398 

 

DEFAULT FEATURES FOR CALA:  the following features will automatically be 
added to New System or Upgrade Keycodes when the conditions are met: 

 

65 – TDET – for all countries in Cala – added to Level 1 for all Large Systems 
200 & 295 – for all countries – in Level 1 – for all 11C & 1000M chassis & cabinet & 
Succession 1000 
227, 228, 286, & 368:  for all countries – in Level 1 – for all Option 61C & 1000M SG 
227, 228, 286, 368, 365 & 299: for all countries – in Level 1 for all Option 81C & 1000 M MG 
227, 228, 286, 298 & 365:  for all countries – in Level 1 for all Option 81s upgrading 
227, 228, & 286: for all countries – in Level 1 for Option 51Cs upgrading  
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OPTIONAL FEATURES FOR CALA – the following features will be added to the 
upgrade keycode automatically if the system upgrading has the feature in LD22 or on 
New Systems if the Order Code for the feature is ordered.  

 

15 – RPE1.5 - for all Cala - can be added to any level for Large Systems 
22 – DISA – for all countries in Cala - can be added to any level for any system type 
57 – BARS – for all countries in Cala - can be added to any level for any system type 
165 – RPE2 – for all countries Cala  - can be added to any level for Large systems 
197 – FTA  for all countries in CALA – can be added to any system level for any system type  
248 – FTA  MPH – for all countries in Cala - can be added to any level for any large system type 
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 EMEA Region - Service Level Content: 

The features in the table below are included automatically in the appropriate service level 
for ALL machine types and ALL countries in EMEA for New Systems and Upgrades. 

Level  4    Premium Network Services  NTE945AA – A0511534 

    207, 321, 325. 
 

Level  3A  Advanced Call Centre Services 

NTE943AA – A0511536 50, 114, 155, 225, 
297, 311, 388 

Level  3B  Advanced Network Services 

NTE944AA – A511535 

37, 38, 39, 62, 67, 159, 175, 183, 188, 

192, 231, 262, 288, 305, 316, 348, 370 

 

Level  2   Enhanced Business Services  NTE942AA – A0511537 

 2, 42, 43, 60, 63, 86, 116, 118, 123, 147, 148, 149, 172, 178  

 209, 263, 306, 307,309, 312, 351, 367, 382, 387, 394, 399 

 

Level  1    Business Services  NTE941AA – A0511538 

0, 1, 4, 5, 7, 8 ,9, 10, 11, 14, 16, 17, 18, 19, 20, 21, 23, 24, 25, 28, 29, 32, 33, 34, 35, 36, 40, 
41, 44, 45, 46, 47, 48, 49, 51, 52, 53, 54, 55, 56,  58, 59, 61, 64, 70, 71, 72, 73, 74, 75, 76, 77, 
79, 80, 81, 83, 87, 88, 89, 90, 91, 92, 93, 95, 98, 99, 100, 101, 102, 103, 104, 107, 108, 109, 
110, 111, 113, 115, 119, 120, 122, 124, 125, 127, 128, 129, 131, 132, 133, 134 137, 138, 139, 
140, 141, 143, 144, 145, 146, 150, 151, 153, 154, 157, 160, 161, 162, 163, 164, 167, 169, 
170, 173, 174, 179, 180, 181, 182, 184, 185, 187, 191, 193, 196, 198, 202, 203, 204, 205, 
206, 208, 210, 211, 212, 214, 215, 216, 218, 222, 229, 233, 234, 235, 236, 240, 242, 243, 
245, 246, 247, 250, 251, 253, 254, 256, 258, 259, 261, 283, 289, 296, 301, 315, 323, 324, 
327, 328, 332, 333, 350, 362, 364, 366, 380, 381, 384, 386, 389, 397, 398 

DEFAULT FEATURES FOR EMEA – the following features will automatically be added 
to New System or Upgrade Keycodes when the conditions are met: 

200 & 295 – for all countries – in Level 1 – for all 11C & 1000M chassis & cabinet & 
Succession 1000 
227, 228, 286, & 368:  for all countries – in Level 1 – for all Option 61C & 1000M SG 
227, 228, 286, 368, 365 & 299: for all countries – in Level 1 for all Option 81C & 1000 M MG 
227, 228, 286, 298 & 365:  for all countries – in Level 1 for all Option 81s upgrading 
227, 228, & 286: for all countries – in Level 1 for Option 51Cs upgrading  
135 – MFE – for France – in Level 1 for all Large and Small systems except Succession 1000 
165 – RPE2 – All countries – in level 1 for all Large Systems 
186 – POVR – for Tele Denmark, Finland and Schrack Poland – in Level 1 for all system types 
190 – UK -  for UK BT and UK Other – in Level 1 for all Large and Small systems except 
Succession 1000 
197 – FTA – for Schrack Poland and France – in Level 1 for all System types 
221 – CIST - for Turkey and CIS – in Level 1 for all Large and Small systems except 
Succession 1000 
232 –PEDM - for Schrack Poland and France in Level 1 for Large Systems 
252 – KD3 – for Spain and Portugal – in Level 1 for all Large and Small systems except 
Succession 1000 
326 & 221 – CISMFS – for CIS  - in Level 1 for all Large and Small systems except 
Succession 1000 
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OPTIONAL FEATURES FOR EMEA – the following features will be added to the 
upgrade keycode automatically if the system upgrading has the feature in LD22 or on 
New Systems if the Order Code for the feature is ordered.  

 

22 – DISA – for all countries in EMEA - can be added to any level for any system type 
57 – BARS – for all countries in EMEA - can be added to any level for any system type 
186 – POVR – Any country other than Denmark, Finland or Poland  - any level and any system 
type 
221 – CIST – for Finland & Poland – add to any level for all Lrg  & Small systems except 
Succession 1000 
284 – DPNSS – for all countries in EMEA - can be added to level 3b or higher for any system 
type 
304 – ARDL – for Israel – can be added to any level for any system type 
326&221 – CISMFS – For Turkey, Finland, Poland – add to any level for all Large & Small 
systems except Succession 1000 
353 – RUCM – for CIS – can be added to any level for Option 11C, 61C and 81C only 
395 – M3900Med – for Israel - can be added to any level for any system type 
396 & 304 – M3900 RGA – for Israel - can be added to any level for any system type 
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North American Region - Service Level Content 
 

The features in the table below are included automatically in the appropriate service level 
for ALL machine types and ALL countries in the region when the Service ISMs for the 
service level are Ordered for New Systems and on Upgrade to Succession 3.0 from a 
previous release 

 

Level  4    Premium Network Services  NTE915AA – A0511519 

     207, 321. 
 

Level  3A  Advanced Call Centre Services 

NTE913AA – A0511521 

 50, 114, 155, 224, 225, 249, 297, 311, 388, 
393 

 

Level  3B  Advanced Network Services 

NTE914AA – A0511520 

. 37, 38, 39, 62, 67, 158, 159, 175, 183,  192, 219, 
305, 316, 348. 

 

Level  2   Enhanced Business Services  NTE912AA – A0511522 

  2, 26, 27, 42, 43, 60, 63, 86, 116, 118, 147, 148, 149,152, 172, 178  

  209, 263, 306, 307, 312, 331, 334, 351, 382, 385, 387, 394, 399 

 

Level  1   Business Services   NTE911AA – A0511523 

0, 1, 4, 5, 7, 8 ,9, 10, 11, 12, 13, 14,  16, 17, 18, 19, 20, 21, 23, 24, 25, 28, 29, 32, 33, 34, 35, 36, 
40, 41, 44, 45, 46, 47, 48, 49, 51, 52, 53, 54, 55, 56,,57,  58, 59, 61, 64, 70, 71, 72, 73, 74, 75, 76, 
77, 79, 80, 81, 83, 87, 88, 89, 90, 91, 92, 93, 95, 98, 99,, 100, 101, 102, 103, 105, 107, 108, 109, 
110, 111, 113, 115, 117, 119, 120, 121, 125, 127, 129, 132, 133, 139, 140, 141, 145, 146, 150, 
151, 153, 154, 157, 160, 161, 162, 163, 164, 167, 170, 173, 174, 179, 180, 181, 184, 185, 186, 
191, 202, 203, 204, 205, 206, 208, 210, 212, 214, 215, 216, 218, 222, 223, 229, 233, 234, 235, 
240, 242, 243, 245, 246, 247, 250, 251, 253, 254, 256, 258, 259, 291, 296, 301, 310, 315, 324, 
327, 328, 329, 330, 332, 333, 350, 362, 364, 380, 381, 384, 386, , 397, 398 

 
DEFAULT FEATURES FOR NORTH AMERICA– the following features will 
automatically be added to New System or Upgrade Keycodes when the conditions are 
met: 

15 – RPE1.5 – for all countries – in Level 1 for large systems only 
65 – TDET – for all countries – in Level 1 for Large Systems only 
200 & 295 – for all countries – in Level 1 – for all 11C & 1000M chassis & cabinet & 
Succession 1000 
227, 228, 286, & 368:  for all countries – in Level 1 – for all Option 61C & 1000M SG 
227, 228, 286, 368, 365 & 299: for all countries – in Level 1 for all Option 81C & 1000 M MG 
227, 228, 286, 298 & 365:  for all countries – in Level 1 for all Option 81s upgrading 
227, 228, & 286: for all countries – in Level 1 for Option 51Cs upgrading  
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OPTIONAL FEATURES FOR NORTH AMERICA – the following features will be 
added to the upgrade keycode automatically if the system upgrading has the feature in 
LD22 or on New Systems if the Order Code for the feature is ordered.  

 

22 – DISA – for all countries in N.A. - can be added to any level for any system type 
57 – BARS – for all countries in N.A.  - can be added to any level for any system type 
248 – MPH- – for all countries in N.A. - can be added to any level for any large system type 
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Defense Switch Network North America - Service Level Content 
 

The features in the table below are included automatically in the appropriate service level 
for ALL machine types and ALL countries in the region when the Service ISMs for the 
service level are Ordered for New Systems and on Upgrade to Succession 3.0 from a 
previous release 

Level  4    Premium Network Services  NTE975AA – A0514085 

     207, 321. 
 

Level  3A  Advanced Call Centre Services 

NTE973AA – A0514083 

 50, 114, 155, 224, 225, 249, 297, 311, 388, 
393 

 

Level  3B  Advanced Network Services 

NTE974AA – A0514084 

37, 38, 39, 62, 67, 158, 159, 175, 183, 192, 219, 
305, 316, 348. 

 

Level  2   Enhanced Business Services  NTE972AA – A0514082 

  2, 26, 27, 42, 43, 60, 63, 86, 116, 118, 147, 148, 149,152, 172, 178  

  209, 263, 306, 307, 312, 331, 334, 351, 382, 385, 387, 394, 399  
 

Level  1   Business Services   NTE971AA – A0514080 

0, 1, 4, 5, 7, 8 ,9, 10, 11, 12, 13, 14, 16, 17, 18, 19, 20, 21, 23, 24, 25, 28, 29, 32, 33, 34, 35, 36, 
40, 41, 44, 45, 46, 47, 48, 49, 51, 52, 53, 54, 55, 56,,57,  58, 59, 61, 64, 68, 69, 70, 71, 72, 73, 74, 
75, 76, 77, 79, 80, 81, 83, 87, 88, 89, 90, 91, 92, 93, 95, 98, 99, 100, 101, 102, 103, 105, 106, 107, 
108, 109, 110, 111, 113, 115, 117, 119, 120, 121, 125, 127, 129, 132, 133, 139, 140, 141, 145, 
146, 150, 151, 153, 154, 157, 160, 161, 162, 163, 164, 167, 170, 173, 174 , 179, 180, 181, 184, 
185, 186, 191, 202, 203, 204, 205, 206, 208, 210, 212, 214, 215, 216, 218, 222, 223, 229, 233, 
234, 235, 240, 242, 243, 245, 246, 247, 250, 251, 253, 254, 256, 258, 259, 291, 296, 301, 310, 
315, 324, 327, 328, 329, 330, 332, 333, 350, 362, 364, 380, 381, 384, 386, , 397, 398 

 

 
DEFAULT FEATURES FOR DSN N.A.– the following features will automatically be 
added to New System or Upgrade Keycodes when the conditions are met: 

 
65 – TDET – for all countries – in Level 1 for Large Systems only 
200 & 295 – for all countries – in Level 1 – for all 11C chassis & cabinet &  
227, 228, 286, & 368:  for all countries – in Level 1 – for all Option 61C  
227, 228, 286, 368, 365 & 299: for all countries – in Level 1 for all Option 81C  
227, 228, 286, 298 & 365:  for all countries – in Level 1 for all Option 81s upgrading 
227, 228, & 286: for all countries – in Level 1 for Option 51Cs upgrading  
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OPTIONAL FEATURES FOR DSN N.A. – the following features will be added to the 
upgrade keycode automatically if the system upgrading has the feature in LD22 or on 
New Systems if the Order Code for the feature is ordered.  

 

15 – RPE1.5 – for all countries – in Level 1 for large systems only 
22 – DISA – for all countries in N.A. - can be added to any level for any system type 
57 – BARS – for all countries in N.A.  - can be added to any level for any system type 
248 – MPH - – for all countries in N.A. - can be added to any level for any system type 
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F 
Cleaning Log Files  

To be completed 
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G 
Order Pro Error Code Listing 

 
To be completed 
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